Sound Automation Manager

Cue Automation Software

Installation & User Manual

tudnt‘)



The contents of this manual are valid up to and inclusive of v1.07

CADAC Electronics plc

One New Street

Luton

Bedfordshire

LU1 5DX

England

Tel +44 (0) 1582 404 202

Fax +44 (0) 1582 412 799
email: info@cadac-sound.com

While every effort has been taken to ensure the accuracy of the contents in this manual, CADAC Audio Mixing Consoles are being subject to
continuous development, hence the information in this manual may not reflect latest product updates.
© Copyright CADAC Electronics plc 2005



Table of contents

Table of contents

Introduction...ccccue e sen e ssn s s e e n a e ananan V

1 Installing the Sound Automation Manager.......... 1-1
11 COMPULEr FEQUIFEMENTS .....eeeiieieiiiee ettt 1-1
12 Installing from CD-ROM .......c.ciiiiiiiiiiiiiee e 1-1
1.3 Installing from FIOPPY DiSC.......coeiuiiiiiiiieiiie e 1-2

14 Communicating with the console ..
15 Powering-up sequence of PCs .. .
1.6 Further instructions and Help...........coooveeiiiiiiei e 1-3

2 Set the console configuration ......cccuecimsnesiemnnnnnes 2-1

2.1 SAMSEIUPD «o et 2-1
2.1.1 Configuring the frame................
2.1.2 Saving a frame configuration ....

2.1.3 Importing a console configuration .2-5
2.1.4 Exporting a console configuration .............ccceeeveeeriieeenns 2-6
2,15 UNAO..iiiiiiiiic e e 2-7
21,6 SBAMNCE ....cciiiie it 2-8
2.1.7 UPdate SEANCE ....cccveiiiiiiiieiiie ettt 2-9
2.1.8 GetMaps & PULMAPS ......coveiiiriiririiiies et 2-10

3 Basic Windows® terminology .....ccusssssmsnsmusnnnnnnns 3=1

3.1 Finding the Sound Automation Manager program ..............c......... 3-1
3.2 The Parent WiNdOW ..........cccoooieiriiienniiien e .32
3.2.1 The Child Windows ... .32
3.2.2 Lock Views............. .32
3.23  The Title Bar.....c.ccoviiieiiiiiiie e 3-2
3.24  The MENU BAr .....ccoociiiiiiiiit e 3-2
3.25  The TOOI Bar(S) .. eeveeeieeieiiiie ettt 3-3
3.2.6  FUNCHON KEYS ... i 3-3
3.2.7  MOUSE ClICKS......evieiiiiiii et 3-3
3.2.8 The Mouse Pointer Shape ........ccccceeeviieieniiee i 3-4
3.2.9 Context SeNSItivVe MENUS .........ccorireeereiieniie e e 3-4

4 Starting a show...ccccciesimsimsisms i snsssmnnmnnnees 41

4.1 Starting the Sound Automation Manager...........cccceevvvenineeeeninnnn. 4-1
4.2 The Cue WiNdow ..........ccceevveeiiiiiiinnnnn .4-1
4.3 The Cue CUrISOrS......ccocceiiiiiiiiie e .4-2
4.3.1 Locking and unlocking the cursors.. .4-2
4.3.2 The EdIt CUISOr......cccviiiiiii i 4-3
4.3.3  The Current Cue CUISOr........ccoooviivieiiiiiiiesie e 4-3
4.3.4 Operating with locked CUrSOrS.........cccceevviveeriiiiien e 4-4
4.3.5 Cursor response to console commands.............cccceeveeeen. 4-4
4.4 Creating @ NEW SNOW ........c.iiiiiiiiiiiie e
4.5 Working with Cue NUMDEIS ........ccoiiiiiiiiiiiiee e
4.6 Selecting Cues.........c.cceevvueen.
4.6.1 Saving data to a cue .
4.6.2 Recalling a cue.......... .
4.6.3 AddiNg @ NEW CUE .....ceoviiiiie ettt
4.6.4 RenUMDEriNg CUES .......ooeiiiiieiiiiee e
4.6.5 Moving cues in the Cue WINdOW.............ccceevieeieninercnenen. 4-9
4.6.6 Moving cues using Cutand Paste............cccceeeveveenrnen. 4-10
4.6.7 Deleting CUES.......ccceevrvieeriiieeens .. 4-11

4.7 Editing the cue title.. 4-11
4.8 Undo/Redo.............. .. 4-12

4.8 1 UNCO LiSt.iviciiiiiciiiie e 4-12
4.9 Cut, CopY and PASe..........covvriiiiiriiiiie et 4-13

Revision SAM2005-2

Sound Automation Manager



ii Table of contents

5 Configuring the Sound Automation Manager ...... 5-1

5.1 SEAMt-UP OPLIONS ..eeeiiii ettt 5-1
5.2 SEIECT USEI ...t 5-2
5.3 USEI PrOPEITIES . ..eeiiiie ettt ittt 5-3
5.4 VIEW PrOpPerti€S. ...cccoiuiiiiiiiie et 5-4
5.4.1 The Grid class VIEWS .........cccccciiiiiiviciiiiiiie e 5-4
5.4.2 Hiding Columns............. 5-5

5.4.3 Moving columns...

5.4.4 Editing features. ... 5-5
5.5 DIFECIOMES ..ttt 5-6
5.6 COMMUNICALIONS ..ottt ettt nin e e 5-6
5.6.1 Open COMMUNICALIONS ......ceeviueeiriiierariee e ee e s 5-6
5.6.2  Tracking ..cccooeveeiiiiie it 5-7
5.6.3  Remote CONrol........ccevviiiiiiiiie e 5-7

6 Opening and Saving ShOWS....ccceuusmsmmssssnmssmsnnnnnas 6-1

6.1 OPEN 1aSE SNOW ...t e e 6-1
6.2 Open a new show... e 6-1
6.3 Saving a show ........... e 6-2

6.3.1 Backup Show... ... 6-3
6.3.2  ReStore Show .........ccooiiiiiiiiiiii i 6-3
6.4 EXPOrt and IMPOrt .........ocuiiriiiiiiie e 6-4
6.5 Show and console mapping conflict ............cccoeiriniieeiiic e 6-4
6.6 Load from CONSOIE .........cccvviiiiiiiie i 6-4
6.7 Load from ShOW .........cccciiiiiiiiiii e 6-5
6.8 RE-MAPPET ...ttt e 6-5
6.8.1 Re-Map upon opening a Show .. ... 6-5
6.8.2 Creating LiNKS ......c.ccooviiiiiieciiiee e e 6-7
6.8.3 Re-Mapping a correctly configured console. ... 6-8
6.8.4 Save and Load linkK files ..........cccoceiviiiiniiiiinii e 6-8
6.8.5 Translation and partial translation............cccccceeerivieenienen. 6-8
6.9 What constitutes a show on the hard disk ..............cccocciiiinnnn 6-9
6.9.1  Showname.CUE ..........ccevviieiiiiiin e 6-9
6.9.2
6.9.3
6.9.4

7 Viewing and editing the Cue data .......ccccveeueenennn 7-1

7.1 Opening the Data Editing WiINAOWS ...........cooiieiriiiicniiee e 7-1
7.2 The Fader frame window(s)............. e 1-2
7.2.1 The Fader detail window .. 7-3
7.3 The Module Frame Windows........ e 1-4
7.4 Naming the console Modules ...........cccceviiiiriiin e 7-5
7.4.1 Using the module NAMEeS .........cccocuveeriiiieniiiicnee e 7-6
7.5 Fader/Module Sets ..........cccocciiiiiiiiiii e 7-7
7.6 Master Title Database VIeW..........c.ccccoviiiiiin i 7-8
7.6.1 Ripple-through feature ..... .7-8

7.7 Additional functions....

7.7.1 Global editing ........ccccceeeveeenineenne e 79
7.7.2 Selecting the data to be updated ............c.ccceeeriierennnnn. 7-10
7.7.3 Selecting the faders/modules to be set.............ccceeeneee. 7-11
7.7.4 Selecting the CUES........ccccveiiiieeiiiieee e 7-11
7.7.5 CUE NOES......ooiviiiiiiiicn 7-12
T.7.6  PrINNG .ccoviiiiiie e 7-12

8 MIDI featureS. . smnesnsnenenenssnenssnensnnenanasnanannnns =1

8.1 MIDI POrt MAPPING ...veeeieeieriiie ettt e 8-1
8.1.1Advanced mapping features .........cccceuvereriereieieeisee e 8-1

8.2 Static MIDI data .........cceeiiiiii i 8-2

8.3 MIDI Program Change..........cccccouvveeniiinenennanes ... 85
8.3.1Entering data for MIDI program change
8.3.2USA or Japan format ..........cccceevvvveriieeennnes

8.4 MIDI NAMES ..o

8.5 MIDI Machine Control...........cccoviviiiiiiiii e

8.6 MIDI SYSEX VIBW ...ttt ettt

8.7 Dynamic MIDI data .......ccueeeeieriiiieiee e s
8.7.1MIDI Sequence List ........cccceeviieeinininenn.

8.7.2MIDI Sequence attachment dialog box

Sound Automation Manager Revision SAM2005-2



Table of contents

8.7.3 Merging of MIDI SEQUENCES .......c.ccvveririeeiiiee e 8-10
8.7.4  MIDI sequence CONtrol ..........cccuveriivierinin i 8-11
8.7.5 Converting a standard MIDI sequence............c.ccceecvueeen. 8-12
8.8 EVENS ..o 8-13
8.8.1 EVENtNAMES ......ceeeiiiiiiiiiic i 8-14
8.9 X-ACt INAICALOIS.......uiiiiiii i 8-15

Dynamic CUes ..ccieuimmmrmmsmmnmmmsnssnsssnnsnsnsmnsnsnnnnnnnnnnnnn 9=

9.1 DefiNItioN ... 9-1
9.1.1  Recording @ MiX ......ccoceeeeiiiiriiiiee e 9-1
9.1.2 Replaying a Mix... .9-2
9.1.3 Editing a Mix........ .9-2
9.2 The MIXtree ......ocovieiiiiii .9-3
9.3 Recalling Static Cues while a mix is playing .........ccccccoevvveniieeennns 9-4
9.4 Replaying two overlapping MiXeS ..........cocceeeririeeniieeerniieeeniee e 9-4
9.5 The step time feature ... 9-5
9.6 Cross fade Control..........ccccceeviiiiiiiicii 9-6

111 [=) | Ay | || ] = €y |

Revision SAM2005-2

Sound Automation Manager



iv Table of contents

Sound Automation Manager Revision SAM2005-2



Introduction %

Introduction

Welcome to the CADAC Sound Automation Manager (SAM). This manual will
describe the various procedures and actions needed to fully utilize the Sound
Automation Manager and achieve flawless performance. Being the result of 20 years
research, development and investment, it goes without saying that CADAC's software
embodies a highly flexible and capable package, reflecting the continuously
increasing requirements of Sound Engineers all over the world. The Sound
Automation Manager’s boundaries are virtually limitless - applications range from that
of a completely stand-alone system to the vast support of multiple frame consoles with
equal ease.

The concept of SAM ensures that the highest levels of control can be achieved -
whether operating complex multiple frame consoles or providing a complete and
accurate picture as digital audio technology progresses towards increasingly smaller
work surfaces. Furthermore, the Sound Automation Manager and its setup program
have been extensively rewritten to support Unicode languages, allowing you to enter
and store the cue text in your own language. Future versions of the Sound Automation
Manager will be available in native languages. Contact your local CADAC
representative for more information.

The CADAC product line is being continuously developed. Consequently, it may
follow that this manual does not include details of features that recently have been
added. If so, you may find it useful to check SAM'’s on-line HELP-system, or go to the
CADAC web site at www.cadac-sound.com. Another option may be to check the
supplied CD-ROM for a later version of the manual. Also, make sure that you always
check the installation disk for a ReadMe file.

Support is of course also available directly from CADAC. You are very welcome to e-
mail your enquiries to us on info@cadac-sound.com. If you know the name of the
person you need to talk to, then just replace ‘info’ with the first name of that person.
Alternatively, you may specify the department, for example “Sales”.

CADAC can also be contacted via mail or telephone/fax:

CADAC Electronics plc

One New Street

Luton

Bedfordshire

LU1 5DX

United Kingdom

Phone: +44 (0)1582 404202
Fax: +44 (0)1582 412799

At CADAC, customer focus is always at the forefront and we will be more than happy
to discuss your suggestions as to how our products could be improved. Therefore,
please feel free to submit your ideas, suggestions or requirements, and we promise
to give you our full attention.
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1 Installing the CADAC
Sound Automation Manager

1.1 Computer requirements

To run the Sound Automation Manager requires a computer with the minimum per-
formance and peripherals as listed below:

IBM PC compatible computer

Windows ® ‘98 (second edition), 2000, XP or XP Pro

Graphics card 1024 x 768 pixels, High Colour 16-bit or better
Ethernet interface 10Mbit/sec with 10base2 connector (BNC)?!

128 MB RAM

20 MB free hard disk space

PS/2 keyboard (older 5-pin DIN keyboard can be used with adapter)?

PS/2 mouse or pointing device (9-pin’D’-serial devices cannot be used)3

1.2 Installing from CD-ROM

The Sound Automation Manager software is normally supplied on a CD-ROM. To
install SAM, place the CD in the CD-ROM drive on your computer. Depending on the
supplied version of SAM, the installation process may or may not start automatically.
If it does not, follow these steps to manually install the software:

B In the Windows Start menu, click on Run.... A dialog box opens, see fig 1-1. In

the box Open, type D:\setup.exe and click OK. If your CD-drive has a different letter
assigned to it, substitute this letter for D.

Run EHE

Tuope the name of a program, folder, document, or [nternet
resource, and Windows will open it far pou.

Gpen ]

FIG 1-1. The Run program dialog box

The installation process starts and you will be guided through each step. Each set-
ting has a default option. Accept the default option unless a CADAC engineer or
other qualified person has instructed you otherwise.

1. The Seance box is supplied with 2 10base2 cables, 2 T-pieces and 4 terminators.

2. The Seance box interface can switch 1 keyboard, 1 mouse and 1 monitor between 2 com-
puters. The Seance box is fitted with PS2 connectors.

3. See2.
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1-2 Installing the CADAC Sound Automation Manager

1.3 Installing from Floppy Disc

If your copy of the Sound Automation Manager has been supplied on diskettes,
insert the diskette labelled 1, in the diskette drive on your computer.

In the Windows Start-menu, click on Run.... A dialog box opens, see fig 1-1.

In the box Open, type A:\setup.exe and click OK. If your diskette drive has a different
letter assigned to it, substitute this letter for A.

The installation process starts and you will be guided through each step. Default
options are offered for each setting. Accept the default option, unless a CADAC engi-
neer or other qualified person has instructed you otherwise.

14 Communicating with the console

The Sound Automation Manager communicates with the console either via the
Seance interface or uses USB technology.

In the case of a Seance interface, Ethernet hardware and TCP/IP software for com-
munications is used. Current consoles use the proprietary CADAC Fast Copper
Comms system (or the earlier fibre optic system). To use the SAM software, CADAC
has designed an interface unit called Séance. This interface links the console com-
munication system with the new world of Ethernet. See the Seance manual, section
2, for further information.

Newer products, for instance the R-Type console, have been equipped with USB
connectors, which eliminates the need for a Seance unit. Setting up a USB commu-
nications system is easier than TCP/IP - the only action required is to tick a box in the
dialog box. The USB driver and interface system can handle all of our USB-based
products, meaning once the driver is installed it is globally available.

Where SAM is set up to use USB communications, it also runs a smaller helper pro-
gram called SamUSB, which is accessible from the system tray at the bottom right of
the screen. A green tick on the SamUSB icon indicates that the program has found
one or more USB products to communicate with. Available units can be listed by
right-clicking the icon and select ‘Status’ from the pop-up menu. You then enter the
unit ID in the Network Settings dialog to let SAM know which unit to communicate
with.

1.5 Powering-up sequence of PCs

Always use the following procedure:

B Power-up console

B Select PC1 on the CCM and power up the first computer. Wait until the PC1
computer has completed its boot-up routine, then...

B Switch to PC2 on the CCM and power-up the second computer and wait until it
has completed its boot-up routine.

B Power-up the Seance-box.

Once both computers have booted correctly, they should allow the keyboard and
monitor to be switched back and forth without problems.

If the overall cable length for the keyboard and monitor are very long (greater than
5m), it may be necessary to use a keyboard and a monitor booster unit to retain key-
board reliability and clean monitor display.
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1.6 Further instructions and Help

After you have installed the Sound Automation Manager, there will be a Readme file
in the SAM menu entries in the Windows® Start menu. Always read this file to check
for changes and new features in the program if you have installed a new version.
When running the Sound Automation Manager or the SamSetup you will have
access to the usual help facilities provided by programs running under Windows®. If
you need to look up a subject and it is not included in the help-file, please let us know
by fax or e-mail. The help-file will then be updated accordingly on a later release.
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2.1

Set the console configuration

SamSetup

After you have installed the Sound Automation Manager, it will appear as a new sec-
tion in the program folder of the Windows® Start menu. One of the entries in this
section is Sam Configuration. Click on this menu entry to run SamSetup. The Setup
window opens, see fig 2-1.

The first thing you need to do in Setup is to select the console type:

B In the Setup window, fig 2-1, click on Console in the menu bar.
B In the drop-down menu, click on Change Console.
B Select the desired console by clicking one of the options in the dialog box.

Click Console

P 5amSetup V1.03
File Undo Seance Maps

Click Change console

Help

— Frame Tatalz Conzole
lvgitiren o s Frame2 Frame3 Framed Total .
Modules 55 27 0 1} a2 JT
|2 Fi - ¥Re
rames Faders 55 27 00 0 82
— Frame Configuration
Cunient Frame E
Index Fader Type Module Type Fader Fey M odule Key
ﬂ 1 | [7937) Mator Mono Channel Fa | [7436) Dual Input Channel Mac | [0 Blank [ EBlank. =

z | [¥937] Motar Mono Channel Fe

| [749E] Dual Input Channel Mo

[7937] Motar Mono Channel Fz

[749E] Dual Input Channel Mo

[7937] Matar Mono Channel Fz

[749E] Dual Input Channel Mo

| (7937) Mator Mona Channel F:

| [749E] Dual Input Channel Mo

| (7937) Mator Mona Channel e

| [74396] Dual Input Channel ko

[7937] Matar Mano Channel Fz

[749E] Dual Input Channel Mac

[7937] Matar Maono Channel F:

[749E] Dual Input Channel Mac

W [7936) Mono Charnel | (6307) Basic Chanr
[ [7937) kotor Mono CHE (7496) Dual lnput ©
[ [7934] Sterea Channe | (7830) Dual Input C
[ [7935] kator Steren C|I] [7865) Steren Char
W [7955) kaster Fader |0 [F302) Standard Gr
[ [7356] kator Master F|l] [7925) Programmat
0 (7372) Programmat
0 (7974) Dsc/PFL me
0 (6309) Aumiliary Ou
0 [FS1E] PRM Mk =]

 Seance

&

Click one of the options ——5& ¢

FIG 2-1. The SAM Setup window

1
2
3
4

900

w00 -
in i N i

Change console type *

i) Tupe

M Tupe

F Type
Concert

B Type
Besenved
Fesenved
Fesened
Besenved

Canecel |

Next, enter the number of frames that constitute the console.
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2-2 Set the console configuration

B Select the appropriate number in the Number of frames menu selection in the
section Frame totals, see fig 2-2.

Select number of frames Select frame

P samSetup V1.03
File Undo Seange Mapz Conszole Help
— Frame Tatalz Caonsole
it f Eheries o Fr;gﬂﬂ Frazn;e2 Franme3 FraDme4 Tg;al .
odules J Type
|2 F 'l
il Fades | 55 27 0 -
Single Frame
i Fr{ 3 Frames
et Frame | Frame 1 'l
Index Fader Type fodule Type Fader K.eyp Module Key

[7498) Dual Input Channel Moy | [0 Blark [ Blark =
W (7936) Mono Channel | (6907) Basic Charr
(7436) DuslInput Channel Mot |y 7937) Moror Mana CHIL (7496) Dual Input €
[7496] Dual Input Channel Mo | [ (7934) Stereo Channe [ (7230) Dual Input
[ [7335) Mator Sterea C |l (7965) Sterea Char
W (7355) Master Fader |0 (5308) Standard Gr
5 |[?83?]MotorMono Chanrel Fz |[?498]Dual|nput Channel koo 0 (7956) Motar Master F |l [7325] Pragrammat

:‘I 1 | [7337] Motor Mono Chanel Fz
2 | [7937] Matar Maona Channel Fz
e | [7937] Matar Maona Channel Fz
4 | (7937) Motor Mono Channel Fe | 7496] Dual Input Channel Mot

B | (7937) Motor Mono Channel F: | [7436) Dual Input Channel Mo [l (7372) Programmat
W [7974) Osc/PFL me
7 | [7337] Motor Mono Channel Fz | [F436] Dual Input Channel Mo 0 (6309] Ausiliany Ou
| 8 | [7937) Motar Mono Channel Fe | [7438) Dual Input Channel Moc 0 (6316 PRM Mk =]
Seance
m | &
SR NNNNNEN RN RNANANNAEENEEEE

FIG 2-2. Selecting number of frames to configure.

Once the console type and number of frames have been selected, select the frame
into which you want to add modules. If the frame you want to edit is not shown, click
on the arrow to view the Current Frame menu (see fig 2-2). When you have placed
modules in each frame, SAM can generate a picture of the console on the VDU
screen (see fig 2-3). This picture will assist you in entering cue information and get-
ting an overall view of console performance without you having to have access to the
console itself.

EE; Fader Frame1 [1.00] Large Bang [[7936) Mono Channel Fader 7] O x]

FIG 2-3. In SAM the computer generates a picture of the console on the screen.
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Configuring the frame

In the SAM Setup window, the individual Frame configuration has two columns,
Fader type and Module type (see fig 2-4). The columns may show up to 64 positions.
The number in the index column indicates the frame position of each module or
fader. Use the scroll bar to show more positions.

B To select module or fader type, move the cursor over the box in the desired posi-

tion in the module column.
B Click in the box. Each click moves on to another module type.

Select module type

P 5amSetup V1.03
File Undo Seance Maps Conzole Help
 Frame Taotalz Conzole
lvgitiren o s "y Fr;;ﬁnﬂ Fra2r;e2 F aDme3 FraDrne4 Tg;al .
odules J Type

2F

il Fades 55 27 |0 7

Index Fader Type Module Type Fader Fey M adule Key

:‘I 1 | (7937) Motor Mono Channel Fz | (7435) Dual Input Channel Mor | [0 Blank [ Blark =

2 | [7937] Mator Mono Channel Fz |[?498] Liual Input Channel Mo
3 | [7937] Mator Mono Channel Fz |[?498] Dual Input Channel Mo
4 |(7937) Motor Mona Channe F2 | (7436] Dual Input Channel Mot
5 | [7937] Motor kMono Channel Fz | [749E] Dual Input Channel Mo
E | [7937] Motor kMono Channel Fz | [749E] Dual Input Channel Mo
[7937] Matar Mono Channel Fe | [7496] Dual Input Channel Mot

-

| 8 | [7937) Matar Monao Channel F& | [7436] Dual Input Channel Mo

W [7336] Mono Charnel | (6907 Basic Chanr
[ [7937) kator Mono CHE (7496) Dual Input C
[ [7934) Stereo Charne | (7330) Dual lnput C
[ (7335] Matar Sterea C|I] [7965) Sterea Char
W [7355) kaster Fader |0 (6308) Standard Gr
[ [7956] kator Maszter FII [(7925) Programmat
I [7972] Programmat
0 (7374) Dsc/PFL me
0 (5309 Avmiliary Ou
0 (ES1EIPRM Mk =]

et i e it %

Seance

Click-drag a block of modules

FIG 2-4. Select modules by clicking on them and then right-click to show a menu or drag a box around the modules and

then right-click.

For each module being selected, a corresponding coloured block is added to the
frame simulation block row at the bottom of the window. A colour key indicating the
type of module or fader that has been selected is located on the right hand side of

the window.

Another way of selecting module types is to click-drag in the block row:

1. Move the cursor so that it is inside of the box that contains the frame simulation

block row.

2. Press and hold down the left mouse button while dragging a box around the

desired module positions.

3. Release the mouse button when the desired module positions have been

selected.

4. Click the right mouse button to select module type for the selected blocks.
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Click on File

If you want to change a selection, you can either:

m  Click under the coloured block in the row at the bottom of the window to select
that module, and then right-click to show a menu, see fig 2-4.

B Drag a box around the desired positions in the block row and then right-click to
show a menu. Left-click on your choice.

or

B Click on the box in the desired position in the module column. Each click moves
on to the next module type.

Saving a frame configuration

When all modules for each frame in the console have been added, click on File in the
menu bar and then click on Save or Save and Exit. The setup program will then write
a file with mapping information to the computer hard disk. If you select Save and Exit,
SAM Setup will close down.

Click on Save or Save and Exit

PP samSetup V1.03 * Modified =
File Undo Seange Maps Console Help
{ Conzole
5 Framel FrameZ Frame3 Framed  Total
Import N E Modules 55 27 0 0 a2 . J Typs
Faders 5 27 0 0 82
Export Map ...
Exit N
Current Frame IFrame1 'l
Index Fader Type Module Type Fader Fey M odule Key
ﬂ 1 |[?93?] Matar Mono Channel Fé |[?885] Steren Channel Module | |0 Blank [ EBlank. o
I W [7936] tMono Channel |l (6307 Basic Chatr
2 |[?93?] atar bono Channel Fz |[?4SB] Dual Input Channel koo [ (7337 Motor Mana O] (7498) Dusl Input ©
3 | [7937) Mator Mana Channel F: | [7498] Dual Input Channel Mai | ([ (7934) Stereo Channe [l (7830) Dual Input €
4 | (7937) Mator Mana Channel F | (7438) Dual Input Channel Mo | [ [7325] Mator Stereo )l [7855) Sterea Char
W [7955) kaster Fader |0 [F302) Standard Gr
5 | [7937] Motar Mono Channel Fz |[?498] Dual Input Channel Mac | |7 (7956) Motor Master F|Il (7325) Programmat
6 | (7937) Motor Mono Channel Fz | (7436) Dual Input Channel Mo [ (7572) Pragrammat
0 (7974) Dsc/PFL me
7 | [7937) Matar Mono Channel Fe | [7496) Dual Input Channel Mot 1 (6309] usiliary Ou
| 8 | [7937) Matar Mono Channel Fz | [7436] Dual Input Channel Mo 0 [E916] FRM Mk =]
Seance
m | &
O LU L

FIG 2-5. Saving the mapping information.

If you do not want to keep the setup:

B Click on File in the menu bar and then click on Exit.

Sound Automation Manager
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2.1.3 Importing a console configuration

Console configuration data can be imported from two sources — the Cue file and the
Map file. The Cue file contains console configuration data for the show and the Map
file contains information about various frame configurations.

To import a file with mapping information into SamSetup:

1. Click on File

2. Click on Import

3. Click on Map file or Cue file

B samSetup 'V1.03
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FIG 2-6. Importing mapping information.
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Exporting a console configuration

When you save a console configuration, to SAM (using the command Save or Save
& Exit), the configuration data becomes the current setup of SAM. Hence, it follows

that if you decide to import another configuration to the current setup, the imported

configuration will overwrite the current one and you will lose the initial configuration

data, unless you save it as a separate file. To save the initial configuration data, use
the Export command in the File menu. Data for the current console configuration can
then be exported to a file that can be retrieved at a later point.

Click on File

Click Export map

Bl samSetup V1.03
File Undo Seamce Maps Console Help
Save Conzole
Save and Exit 5 Framel FrameZ Frame3 Framed  Total
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Exit |n
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Click on Save

FIG 2-7. Export a console configuration.
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2.1.5 Undo

If you want to undo an Import or GetMaps request (for information about GetMaps,
see 2.1.8) click on the relevant option in the Undo menu in the file bar of the Sam-

Setup window.

Click Undo Click option

P samSetup ¥1.03
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FIG 2-8. The Undo option.
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2.1.6

Click Séance

P samSetup V1.03

Séance

In order for SAM Setup to be able to communicate with the console, the Séance net-

work port has to be open. To open the port,

select Open Port.

Click Open port

click on Séance in the menu bar and
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Network 5ettings x|
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[194.222. 3310
Sam Setup Port

Verify Network
Settings

FIG 2-9. Open

FIG 2-10. The Seance menu.

RE 1114

Own IP Address

Seance Setup Part

J134.222. 33123

i

—

Cancel |

Click OK

Seance network port.

The greyed out options in the Séance menu become selectable, see fig 2-10.

Click to close port

|§eance tMapz LConsole

Cloze Part

Click to update, see 2.1.7———— llpdate Seance ...

Update Séance

In order to avoid over-writ-
ing essential data,
extreme care must be
observed when using
these options. Further
information available from
CADAC.

Update Config ...

Update Filez ...
Browze Files ...

Sound Automation Manager

Revision SAM2005-2



Set the console configuration

2-9

21.7

Update Séance

To update the Seance program, the Séance box needs to be switched ON and a util-
ity called SAM SETUP needs to be run on the PC.

Update the Séance program from SAM SETUP by performing the following steps:

1.
2.
3.

© ® N

In the SAM SETUP main menu click on Séance.

Click on Open Port.

In the Network Settings window, make sure that the Séance IP-address is identi-
cal to the one specified in Communication Setup on page 8 in the Séance Instal-
lation & User manual

Make sure that the port setting for the Local port is the same as for the SAM
SETUP port.

Make sure that the port setting for the remote port is identical to the one for the
Séance SETUP port (see Communications Setup on page 8 in the Séance
Installation & User manual).

Click OK.

In the SAM SETUP main menu, click on Séance.

Select Update Séance.

When Update has transferred all the files, press the Version button under the dis-
play window on the Séance box. Check that the display shows correct version
number, release date and time for update.

If the update has been successful, the Séance will restart using the new executable.
Itis possible to download other files to the Séance box in this way by using the
Update files option in the file menu.

WARNING: Do not add leading zeros into the IP-address (i.e. the address
194.222.033.011 should be typed 194.222.33.11). If this is not observed, the com-
puter will not communicate.
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21.8 Get Maps & Put Maps

If you want to update a certain console configuration stored in the CCM, click the
Maps menu in the menu bar and select PutMaps. In the same way, if you want to
update the computer configuration with the data from the CCM, click GetMaps.

Click to Get Maps Click to update maps
from CCM in CCM

P samSetup V1.03
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FIG 2-11. Get Maps & Put Maps
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3 Basic Windows® terminology

3.1 Finding the Sound Automation Manager
program

You will find Sound Automation Manager (SAM) in the Windows ® Start menu or you
can create a SAM short-cut on the desktop.

Click on the Windows ® Start-button in the bottom left corner of the screen.
The Start menu opens.

Click on Programs.

Click on the Sound Automation Manager entry

In the sub-menu, click on Sound Automation Manager.

abrwnNE

The SAM -program starts and a window opens, see fig 3-1. Select windows to view
from the tool bar.

Title Bar Menu Bar Tool Bars Child window

33 Cadac Sound Automation Manager T1.05 : 06 - SampleShow - Working Dffline -

File Edit Yiew Option: Mode Window Comms: Help
0| 3|6 [a B8] 2| Blo 8- @] 52 wmese | [
gl =N N 2
A AR
EPIEN=E
EE Cue 9 [=] B3
Cue No Cue Name Time Info X-Act |
1.00 Large Bang 0mo
2.00 Drurn rall 10.00 i~ |n
3.00 Lights down 500 5% [ |
4.00 Curtains up g |[Of (18}
5.00 Do something 1}
6.00 [ ]
7.00 a
8.00 1]
9.00
10.00

FIG 3-1. The main window in Sound Automation Manager
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3.2 The Parent Window

When you start SAM, a window called the Parent window opens, see fig 3-1. In the
parent window you will find the title bar, the menu bar and the tool bars. The rest of
the window constitutes the work area.

3.21 The Child Windows

When you click in the menu bar or the tool bars, new windows will open, displaying
information and giving access to editing facilities. These windows are called the Child
Windows. Each child window shows a different type of data. There may be as many
or as few child windows as required. You can change the size and position of the
child windows to what best suits your current job requirements.

3.2.2 Lock Views

If you have opened several child windows, you may want to maintain their locations
on the screen. Click on Mode in the File bar and then select Lock Views from the
menu.

3.2.3 The Title Bar

The Title Bar contains the Program Name, the version humber and the name of the
current show. Other information may be added as you are creating and editing a
show. This will be described in subsequent sections.

3.24 The Menu Bar

The Menu Bar is a standard feature of most Windows ® programs and gives you
access to various displaying and editing functions. Each entry in the menu bar can
be clicked, causing a drop-down menu to show on the screen. Another way of dis-
playing the drop-down menu is to type the underlined letter in the menu bar entry
while holding down the Alt-key.

Drop-down menu

22 Cadac Sound Automation Manager T1.05 : 07 - SampleShow - Working Difli__ [Si[=] E3
The Menu Bar Fe Edit | Viw Optiofs Mode Window Comms Help

I I BT T A

Ly F1 |F2' F3* F4| 5+ Flil 7 Fal 2] F1I]| 1|F |
Event el = ;m & |[pe En »E ;ZB ;1&2
Module

Master Title
Cue Notes

Toolbars 3

FIG 3-2. Click the entry in the menu bar to show a drop-down menu.
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3.2.5

To select from the drop-down menu, click on the function you require. A child window
with that function will then open.

Another way of accessing a function is to use a short-cut, which is a combination of
holding down Ctrl + the designated letter key. In the menu, pressing Alt + the under-
lined letter in the menu option, selects that option.

The Tool Bar(s)

The Tool bar (see fig 3-3) is another standard feature of Windows ® programs and
provides short-cuts to most of the main functions in the program. In SAM, some of
these tool bar icons have a built in function for opening/closing child windows. This
means that when you click on any of these icons, the icon depresses and a child win-
dow opens. If you click the icon again, the window closes and the icon resumes its
normal appearance.

33 Cadac Sound Automation Manager T1.05 : 06 - SampleShow - Working Dffline -

File Edit Yiew Option: Mode Window Comms: Help
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FIG 3-3. The toolbar function keys.

3.2.6

3.2.7

Tool bar icons

SAM has a number of tool bars for various purposes. These will be described in the
appropriate section.

Function keys

The computer functions keys F1 to F6 have different functions depending on what
view you are in. Function keys F7 to F12 are all associated with recording and play-
ing dynamic cues.

Mouse clicks

Windows ® syntax for using the mouse stipulates the following:

Left click — click the left mouse button oncel
Right click — click the right mouse button once

Double click - click the designated mouse button twice in quick succession
Shift click - click the mouse button while holding down the shift key

Ctrl click — click the mouse button while holding down the Ctrl key

Click drag — press the mouse button and hold it down while you move the pointer.

2

1. Windows can swap the left and right mouse buttons, see Control panel, Mouse in the Win-
dows start menu.

2. You can programme Windows for slower or quicker “double-clicks”, see Control panel,
Mouse, in the Windows start menu.
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3.2.9

The Mouse Pointer Shape

In some circumstances, the mouse pointer changes its appearance when moved.
The change indicates that a certain function is available in that part of the screen.
SAM uses this standard Windows ® feature in a number of instances. These will be
described in the appropriate sections.

Context sensitive menus

Some windows display a menu with a small selection of functions that you are most
likely to use. To access the menu, right-click over the window that is shown on the
screen. The functions available are associated with that particular window and may
vary depending on whether any items are selected.

Sound Automation Manager
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4.1

Starting a show

Starting the Sound Automation Manager

The various user options in SAM allow you to configure the program to start up in
accordance with your requirements. The user options determine for instance what
show to load, whether to place the child windows in the positions they were in when
last used, etc.

Assuming the user options are still set in accordance with the ones on the installation
disc, the SAM start-up screen opens, see fig 4-1.

‘EE Cadac Sound Automation Manager T1.05 : 06 - SampleShow - Working Dffline -

File Edit Yiew Option: Mode Window Comrmz Help
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i Cue = [=1
Cue No Cue Name Time Info X-Act |
1.00 Large Bang Om0
2.00 Drurr roll 10.00 A |1
3.00 Lights down 5.00 53 ] |
4.00 Curtains up B2 D] [N
5.00 Do samething 1}
6.00 [ ]
7.00 0
8.00 1]
9.00
10.00
FIG 4-1. The Sound Automation Manager start-up screen. The Cue window
4.2 The Cue Window

The Cue Window (see fig 4-1) is the primary information area. It shows a list of the
cues that make up a show. Each cue has a number and a name. The cue number is
used for controlling the order in which the cues are placed in the list. The cues in fig-
ure 4-1 are numbered 1.00, 2.00 etc. As each new cue is added, the SAM program
assigns an incremental number to it.

The cue name is to help you keep track of the cues and usually describes what will
occur in the show when you recall a certain cue. It could be the name of a specific
part of the show, for instance the name of a song.

The remaining two columns provide information for the dynamics system, see 9.1.2
Replaying a Mix.
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4.3 The Cue Cursors

When running a show, it is important to know where in the list of cues the show cur-
rently is. To this end, a cursor is moved through the cue list as the show progresses.
This cursor is called the Current Cue cursor.

33 Cadac Sound Automation Manager T1.05: 06 - SampleShow - Working Dffline -
File Edit Yiew Option: Mode Window Commz Help
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5.00 Do something ]}
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FIG 4-2. The Cue window with the cue cursors.

There is another cursor in addition to the Current Cue cursor. This cursor is called
the Edit Cue Cursor and you use it to select a cue that you want to view or edit.

These two cursors have different functions but can be locked together to operate as
one. When they are locked together, the resulting cursor takes on the appearance of
the Current Cue cursor.

4.3.1 Locking and unlocking the cursors

One of the icons in the SAM Toolbar looks like a padlock. Click the padlock to lock/
unlock the cursors. You can also use the lock/unlock options in the Mode menu in the
SAM menu bar or use the short-cut Keys, Ctrl+L to lock or

Ctrl+ U to unlock.

!Iﬂ Cadac Sound Automation Manager ¥1.01 - SampleShow

File Edit Wiew QOption: Mode Window Comms Help
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FIG 4-3. Click the padlock to lock/unlock the cursors.
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4.3.2 The Edit Cursor

The Edit Cursor in the Cue Window (see fig 4-4), allows you to move through the
show and edit each cue as required. The cue that the edit cursor indicates is called
the Edit Cue. Use the keyboard arrow keys to move the edit cursor in the cue list. As
you do this, each cue will be displayed in the views available (see fig 4-5). Provided
the cursors are unlocked, the cue will not automatically be recalled to the console. If,
however, the cursors are locked, the cursor also serves as a Current Cue cursor and
consequently the cue will automatically be recalled to the console.

2 Cue -EE

Cue No Cue Name |
1.00

200
3.00 I Lightedown |
4.00 Curtaing up
5.00 Do sornething Jil7]
6.00 | 1}
7.00 i]
8.00 [ ]
9.00
10.00

FIG 4-4. The Cue window.

The Edit cursor The Current cursor

Recall the Edit cue to the console by pressing F3 (available in all View menus, see
3.2.6 Function keys). Save the console data to the Edit cue by pressing F2 (only
available in Cue view).

3; Cadac Sound Automation Manager T1.05 : 06 - SampleShow - Working Dffline -
File Edit Yiew Option: Mode Window Commz Help
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FIG 4-5. When you select a cue with the edit cursor, the cue will be displayed in the views available. The figure shows
the fader frame view.

4.3.3 The Current Cue Cursor

The Current Cue cursor (see fig 4-4) indicates the cue that, most likely, represents
the current state of the console. This is the cue with the data that was most recently
sent to the console (F3 = Recall Cue) or saved from the console (F2 = Save Cue). If
console data changes, it will not reflect in the state of the Current Cue. The cursor
indication merely serves as a reminder of which cue last interacted with the console.
Use PageUp and PageDn to move up/down in the cue list.
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4.3.4

4.3.5

4.4

Operating with locked cursors

In locked mode, a few operational characteristics for the cursors change. The arrow
keys that were used to move the Edit Cursor will become non-functional. Instead,
use the PageUp and the PageDn keys to control the cursor movement. Pressing
these keys will also have the effect of recalling the cue to the console and thus, the
PageUp and PageDn keys take on the functions Previous and Next.

Cursor response to console commands

When SAM communicates with the console, a number of commands may be issued
from the CCM (Central Control Module). Using the P and N buttons will recall the
previous or the next cue. Using the numerical buttons and the SVE and RCL buttons
will save or recall data to a specific cue. Any of these actions will move the Current
Cue cursor, irrespective of whether the cursor mode is locked or unlocked. There-
fore, when you want to edit a cue, always ensure the cursors are unlocked before you
startl. This allows you to have the console in the required operating mode, while
editing other cues.

Creating a new show

To start a new show, click on the New icon in the toolbar or click on the File option in
the menu bar and then select New Show. SAM then opens a dialog box, see fig 4-6.

Create in - ci\MpShows'
Enter the MEW show

Show Propertie:
Type Frame: 2
J Type Faders 101
Modules 101

Other Comments

Create I Cancel

FIG 4-6. The New Show dialog box.

Enter a suitable name in the white box provided at the top of the dialog box.
Windows ‘98, 2000, XP and XP Pro allows very long file names so you can be quite
explicit. Note that there is another box named Other Comments, in which you can
type in comments relating to the show. These comments will be displayed in the
Open Show dialog box when you are browsing the shows. For the benefit of other
users, it may therefore be a good idea to type in descriptive messages here.

The New Show dialog box also displays a brief résumé indicating the console type
and configuration being used. The résumé will be used later to check against the
active console configuration.

When you have entered a suitable name for the show, click the Create button to save
the current list of cues to the computer hard disk.

1. Alternatively, work in buffered editing mode, see section 7.4.
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4.5

4.6

Working with Cue Numbers

The Cue Numbers controls the order or sequence of the cues. Consequently, chang-
ing a cue number will change the order of the cues. SAM has functions to add,
delete, move and renumber cues and you access them by right-clicking over the cue
number or the cue title column.

Selecting cues

Before you can edit a cue or cues, SAM has to know which cue or cues you want to
edit. Click on the cue number in the left-hand column to select. A coloured bar then
marks the cue, indicating that the cue has been selected (see fig 4-7).

Cue No Time | Cue Name
1.00
1.10 10.00 Drum roll
3.00
4.00 8.20 Curtains up
5.00 Do something

FIG 4-7. A bar indicates the selected cue.

To select two or more cues, proceed as follows:

B Click on the first cue you want to select.
m  Ctrl-click on next cue.
B Repeat for remaining cues.

To select a block of cues:

B Click on the first cue in the block of cues you want to select.
B Shift-click on the last cue in the block of cues you want to select.

To remove the selection bar, click in an unused area of the cue window or press Esc
on the keyboard.
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4.6.1 Saving data to a cue

You may save data to a cue in two ways:

B Press the F2 function key to save data to the current cue.
B Press shift + F2 to save data to a specified cue.

4.6.2 Recalling a cue

To recall a cue, you may either:

B Press F3 to recall the current cue.
B Press shift + F3 to recall a specified cue.
B Right-click in the Cue Window and select Recall Cue from the menu.

33 Cadac Sound Automation Manager T1.05 : 06 - SampleShow - Working Dffline -

File Edit Wiew Option: Mode “Window Comms Help
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7.00 Select Al
8.00 [
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10.00
FIG 4-8. Recalling a cue Select Recall Cue
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FIG 4-9. Adding a cue
to an existing show.

FIG 4-10. Adding a
new cue after a select-
ed cue.

4.6.3 Adding a New Cue

You can add a cue to the existing show by:

B Press the F5 key/click on its icon or press Insert to insert a new cue immediately

after the Edit Cue, or

B Right-click in the Cue View to show a menu (see fig 4-9).

m In the menu, select New Cue to add a new cue to the END of the cue list.

The new cue will be given the next sequential whole number.

Current cue Edit cue

- Working Offline -

[

BE Cadac Sound Automation Managier T1.05 - 06 - SampleShow
Fle Edit Yiew Options Mode Widow Comms Help

D] B@ = 58| ] oo 3]
21 E‘ 5_: Fa ;3; F6

@ o5 ot W8 | ol 2] el
i
Cue Name
1.10 T
0 ecall Cue
1.20 Delete fue
2.00 Drurm rall 10.00 Mowe Clie
3.00 Lights down 500 Retumber Cuz
4.00 Curtains ugp 8.20 |I Efl‘;[;yca\rx
5.00 Do something Select Al
6.00
7.00 i]
8.00 ] =
Right-click in the Click New cue

Cue window to
show a menu

To add a new cue somewhere into the middle of the cue list:

B Select a cue by clicking on its name (a coloured bar appears at the left-hand side

of the window).
B Right-click to show a menu.
B In the menu, click New Cue.

BE Cadac Sound Automation Manager T1.05 : 06 - SampleShow - Working Dfffine -

Eile Edit Miew Options Mode Window Comms Help

] 8] 5 e e w3 2] omen [
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Cue No Cue Name Time Info X-Act
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1.11
1.20
2.00 Dirurn roll 10.00
3.00 Lights down 500 EEIEIEEE
4.00 Curtains ugp 8.20 Ht:;Zm: Cue
5.00 Do something Edit Dyngmic
6.00 Title: & Colour
7.00 Select Al
2.00 |

Select acue Right-click in the window Click New cue

SAM will insert a new cue after the one you selected, and give it an appropriate

number.

Note that the smallest gap allowed between cues is 0.01. Therefore, if you try to add
a cue into a gap that is already as small as it can be, SAM will add the cue with a #in
the cue number column. To give the cue an appropriate number, use the renumber or
move functions as described below.
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FIG 4-11. Renumbering cues.

Renumbering cues

Adding one or more cue(s) between cue 4.00 and 5.00 will result in a cue with a dec-
imal number. If you add many new cues, the cue number structure may become too
complex. To avoid this, you can renumber the cues.

To renumber cues:

B Select the cues you want to renumber using shift-click or Ctrl-click (see section
3 Basic Windows® terminology).

B Right-click in the cue window to show a menu.

® In the menu, click on ReNumber.

BE Cadac Sound Automation Manager T1.05 : 06 - SampleShow - Working Dfffine -
Fle Edit Yiew Options Mode Window Comms Help
NI ERREE R E R |
| e R e om%e [ ]
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AR PRI ol 2] el
B Cue =[0fx]
1 e
—
Cue No Cue Name Time Info X-Act
1.00
1.01
1.10
111
1.20 Fecal Cue
2.00 Drurm rall 10.00 New Cue
3.00 Lights down 500 Delete Cue
Move Cus -
.00 EnEE U 820 | IO guroenrrom
5.00 Do something Edit Dynamic
6.00 Tie & Colaur
7.00 Select Al |
8.00 n =

Select a cue Right-click in the window Click ReNumber

NOTE: SAM will renumber the cues to whole
numbers as far as that is possible. There are
some exceptions to this. For instance, if you
want to renumber cues 5.00, 5.10 and 6.00, then
cue 6.00 cannot become cue 7.00, because that
cue number already exists. If you, however,
highlight cues 5.00 to the end, then all cues will
be renumbered.
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4.6.5

Moving cues in the Cue window

Use the function Move if you have created a cue, or a number of cues and would like
to have the cue or the cues in a different order.

To move a cue, or a group of cues, you can either use the following steps or the
method described in 4.6.6 Moving cues using Cut and Paste™

1.

In the Cue Window, see fig 4-12 below, select the cue or cues to be moved (the

selected cue or cues indicated by a bar on the left).

Right-click to show a menu.

In the menu, click Move to show a dialog box.

In the dialog box, type in the number of the new position in the cue list. If you are
moving a group of cues, this number will be assigned to the first cue in the group.

& Cadac Sound Automation Manager T1.05 : 06 - SampleShow - Working Offline -
Fle Edit Yiew Options Mode Window Comms Help
0 {8 [ e+ B[ 3 Bz omee I
21 E‘ g_: Fa ;‘5:‘ 75
AR PRI ol 2] el
e
—
Cue No Cue Name Time Info X-Act
1.00
1.01
1.10
111
T
120 Fecal Cue
2.00 Drurm rall 10.00 New Cue
3.00 Lights down 500 =
4.00 Curtains ugp 8.20 @ &
5.00 Do something i By
Edit Dynamic
LY Tite & Colaur
7.00 Select All
8.00 =l
Select a cue Right-click in the window Select Move Cue

FIG 4-12. Moving cues in the cue window.

The cue or the cues will be moved to the new position(s) and renumbered accord-
ingly.

Attempting to move a cue to a position already in use generates an error.
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4.6.6

Moving cues using Cut and Paste

In addition to the procedure described in 4.6.5 Moving cues in the Cue window, you
can move cues using the Copy, Cut and Paste functions, available in the Edit menu
or via the short-cuts Ctrl-C, Ctrl-X and Ctrl-V. (C=Copy, X=Cut and V=Paste).

Click Edit Click Cut cue Click Yes Move cue to new position
E’E Cadac Sound Automation Manager T1.05 : 06 - SampleShow - Working Difline -
File |IEdit Wiew Options Mode Window Comms Hel
o U i (=1 R 1 I@.%&ﬁ E‘
i Undo Chl+E . i |
F Fiedo; [Cti
—  EditTile (o
B EdiTielit AT | E_JJM ffglgig
— Edit Dynamic Chil+
Edit Dynarmic List Alt+D) (O] x]
ml CutCue ;l
Lopy Cue Chil+C Cue Name | Time | Info | X-Act |
Bate =
- Selectall Chilss
1.11
1.20
2.00 Drum rall 10.00 0|
3.00 Lights i ]
4.00 Curtaj a0}
5.00 Da sar 00}
5.00 Delete Cue Mo, 2.00 7 7]
7.00 ]
8.00 Yes E [] =

FIG 4-13. Moving cues using the Edit menu.

Select the cue or cues to be moved, see 4.6.4 Renumbering cues.
In the menu bar, click on Edit to show a menu.

In the menu, click on Cut.

Click Yes in the Delete Cue Warning window.

In the menu, click on Paste.

Move the pointer to the new position in the cue list.

Left-click with the mouse.

Nogah,rwNE

The cue, or the cues, will be moved to their new position(s) and renumbered accord-
ingly.

Attempting to move a cue to a position already in use generates an error.

Sound Automation Manager
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4.6.7 Deleting Cues

If you have added cues to the show and at a later stage find that you do not want to
keep them, proceed as follows:

E’E Cadac Sound Automation Manager T1.05 : 06 - SampleShow - Working Difline -
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e
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1.1 Mew Cue
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2.00 Drum rall 10.00 ove Cus
3.00 Lights down 500 [ Fietumber Cue
Edit Dynarmic
4.00 Curtains up g.20 Tltke & Colour
5.00 D samething Select Al
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7.00 1}
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FIG 4-14. Deleting a cue. . L . .
9 Select a cue Right-click in the window Click Delete

B Select the cue or the cues
B Right-click in the cue window to show a menu.
B In the menu, click on Delete.

or select the cue in the Cue Window and press Delete.

The selected cue or cues will be deleted.

4.7 Editing the cue title

To edit the cue title, double-click the left mouse-button on its entry in the cue window.
A dialog box opens, see fig 4-15 below. Enter the new cue title in the white box pro-

vided.
Edit Cue 1.00 x|
Cue Title

I Use Custom Colour

ok I [ Cancel

FIG 4-15. Editing the cue title.

Another way of editing the cue title is to select Edit Title from the Edit Menu.

m  Click on Edit in the File bar and then click on Edit Title.

This option requires the cue to be selected by the edit cursor in the cue window. If
the cue is not selected, you may click on the next option in the menu: Edit Title List

and then select the cue title you wish to edit.

If you want to have the cue in a specific colour, tick the box Use Custom Colour in the
window.

B Note that you can set the title colour for multiple selected cues by right-clicking-
ing in the Cue Window and then select Set Colours from the menu.
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FIG 4-16. The Undo/Redo function.

FIG 4-17. Undo list

4.8

4.8.1

Undo/Redo

By using the Undo option in the Edit menu you can undo some commands issued in
SAM.

B In the menu bar, click on Edit.
A drop-down menu is displayed.

B In the drop-down menu, click on Undo.

Click on Edit Click on Undo

E’E Cadac Sound Automation Manager T1.05 : 06 - SampleShow
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5.00 Do something 00}
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The action you have performed is cancelled, and the show returns to its previous
state.

If you undo something and then discover you did not want to undo it after all, proceed
as follows:

B In the menu bar, click on Edit.
B In the drop-down menu, click on Redo.

Your actions are cancelled and the show returns to its modified state.

Undo List

Click on the upper Undo entry in the Edit menu (see fig 4-16) to open a dialog box
(see fig 4-17 below) listing the contents in the Undo buffer including details of what
has been changed. Any entry in the list can be selected to show more details in the
status lines at the bottom. By selecting an entry in the list, you may undo or redo any
action performed on it.

Undo List

Unio | Und List

Desciiption [ Cuels) [Memor ] 7778

Unda Memary
Limit [KBptes]

100

Memeny Used
[Bytes)

0
Redo (% Fleda List
Description [ Cuels)

Free Memory
|| (Biytes)
700000

Empty Al

rInfo
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4.9 Cut, Copy and Paste

In the Edit menu, you will, in addition to the previously described functions -, Undo
and Redo, also find Cut, Copy and Paste, see 4.6.6 Moving cues using Cut and

Paste. For instance, using the option Cut, lets you cut out a cue from the show and
then paste it back to another position. Similarly, Copy copies a cue to another posi-

tion.

1. Select the cue you want to cut.

2. In the menu bar, click on Edit.

3. In the drop-down menu, click on Cut.

4. In the menu, click on Paste.

5. The line in the cue list where the pointer is now takes on a different colour. Move

the pointer to the new position in the cue list and left-click with the mouse.

The cue is moved to a new position in the cue list.

Select a cue Click on Cut cue Click on Paste

E’E Cadac Sound Automation Manager T1.05 : DG - SampleShow - Working Difline -
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Left-click the new position
FIG 4-18. Moving and copying cues to other positions using Cut, Copy and Paste.

If you want to copy a cue to another position in the cue list:

Select the cue you want to copy.

In the Menu bar, click on Edit.

In the drop-down menu, click on Copy.

In the Menu, click on Paste.

The line in the cue list where the pointer is at now takes on a different colour.
Move the pointer to the new position in the cue list and left-click with the mouse.

aprwNE

A copy of the cue is added to the cue list and given a number incremental to that of
the preceding cue.
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5 Configuring the
Sound Automation Manager

5.1 Start-up options

SAM has a number of start-up options. By clicking the Options menu and then Start-
up, these options can be viewed and changed. A check box on the left-hand side of

each option indicates whether the option has been selected. Click the box to select/

deselect the option.

Click Options  Click Start-up

E’E Cadac Sound Automation Manager T1.05 : 06 - SampleShow - Working Difline -
File Edit iew | Dptigns Mode Window Comms Help

Directories. -
Select User.. JM IQ.%% |_'|_| |

Uszer Properties

Wiew Properties Seq|seq
Habict Indicators % D H;E List | cirl

Channel Sets

Setup Startup Options | ]

Startup
¥ Reload last Show at Startup
W Set last User Settings at Startup

CIICk to seIeCtIdeseIeCt ¥ Reload Window Placements at Startup

Cancel

FIG 5-1. Select Start-up options.

B Select Reload last show to open the show you were working on, when you last
used SAM.

B Select Reload Windows Placement to have the child windows resume the posi-
tions they were in when you last closed the application.

B Select Last User Settings to restore the options of the person last using SAM.
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5.2 Select user

Users can have their own settings for screen layout and colours. Instructions on how
to change these settings can be found in 5.4 View Properties. Select, add or edit the
name of a user by clicking the Options menu and then clicking Select User.

B Click Add New if you want to add a new user.

A new window Add User is displayed.

m  Type in the name of the new user and click OK.

Click Options  Click Select User

E’E Cadac Sound Automation Manager T1.05 : 06 - SampleShow - Working Offline -
File Edit iew | Dptions Mode Mndow Comms Help

Directories
User..
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Startup.
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Select User Settings

Current User CI_ k Add
Defauit iIc new

a:lault Editi&ms
Cancel *

Add User

Enter the Mew User lLI

Cancel I

Enter New user

FIG 5-2. Select, add, edit or delete a User.

The New User will initially have the same settings as the default user, but any subse-
quent changes will be stored in a separate user set-up file. This means that the next
time you start SAM, the program will configure itself in accordance with these set-
tings (provided the option Set last user setting at start-up has been ticked, see 5.1
Start-up options).

To change settings for screen layout and colours, see 5.4 View Properties.
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5.3 User Properties

Clicking this option in the Options menu in the menu bar displays the User Properties
dialog box. The dialog box has five tabs, each of which when clicked, will display self-
explanatory options that can be selected by ticking the associated check-box.

Click Options  Click User properties

- Working Dffline -
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FIG 5-3. User properties dialog box.
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5.4 View Properties

5.4.1 The Grid class Views

You can configure the way SAM displays information on the screen. In the Options
menu, click on View Properties to open a new window that shows various parame-
ters you can change. By clicking on the tab labelled All Views, you can set the com-
mon properties for all windows. Each window then has its own tab that may be
clicked so that additional features can be controlled.

Click Options  Click View properties
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The views displayed in this manner are referred to as the Grid Class Views and
comprise those child windows that display their data in rows and columns. Each row
and column in the Grid Class Views have a “header tile”.

The child window row header shows the cue number and the column header shows
a suitable name which describes the data in the column. In many cases this data is
editable as part of the show file. Editing is done using the Options->View Properties
menu selection, which calls up the View Properties dialog box. The dialog box can
also be accessed by right-clicking over the column header and then select Properties
from the pop-up menu.

View Properties E
Machine Control | StaticMidi | CueMotes | Midi Sequence
Midi Sequence Edt | Module Name List | MIDI SysEx
£l Vigws Cue Event | MasterTile |  Progiam Change
i~ Columr Ibems Wi

Show:

¥ Show Row Lines

Cue No
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contro' COIumns and the W Time Wertical Cell Header optionSICOIourS speeific
N r
way they are displayed & o to one window
ME K 10 ::II Fant Size (pt)
| Dynaric
| Midi
Name | Step

| HFade
1] % I Cancel | e | Help I

FIG 5-5. Dialog box layout

The left-hand area of the dialog box gives you control over the columns and the way
they are shown. You can make columns invisible by unticking the relevant box. The
next box enables you to change the column width and the text is shown in the column
header. The column width can also be changed by right-clicking in the header box,
then choose Column Width from the pop-up menu followed by entering the size in
the associated window. To set the width for multiple columns, click a column to select
it, then use Ctrl-click or Shift-click to add any other columns you want to resize.
Right-click on each column and set the size as previously described.

If you click once on a row in this area it will be highlighted and its name can be edited
in the box at the bottom.(Where editing makes no sense, this area is greyed out).
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5.4.2

5.4.3

5.4.4

The right half of the dialog box provides options/colours that may be set specifically
for one window. These options are generally Show Row Lines, Show Column Lines,
Font Size and Vertical Cell Header.

To change settings for the remaining windows, click on the associated tab and repeat
the procedure. All changes will be saved when you close down and restored the next
time you open SAM

Hiding Columns

Columns can be hidden, either via the dialog box on the previous page or by right-
clicking on the column header followed by selecting Hide from the pop-up menu. If
you make a column invisible, this will be indicated by the corner of the adjacent col-
umn being folded down. Right-clicking the column header with the folded down cor-
ner and selecting Unhide Next from the pop-up menu will make the column visible
again.

Moving columns

The order of the columns can be changed by right-clicking the column header fol-
lowed by selecting Move Right or Move Left from the pop-up menu.

Editing features

The Grid Class Views editing facilites for copying and pasting data between cells,
rows or columns, work in a fashion similar to that of Microsoft Excel as this will be
familiar to most users. You select row/column by clicking on the row/column header.
Select cells by clicking on them. Multiple selections can be made using Shift-click or
Ctrl-click. A block can be selected by dragging out a boundary box. Selections can
be cancelled by clicking another selection or an area that does not contain cells.

You can mark a selection for copying using Ctrl-C or the copy option on the Edit
menu. The marked selection will then be shown with a dotted line around it. Then the
data may be copied to a region selected elsewhere, by using Ctrl-V or the Paste
option on the Edit menu. The “mark for copying” may be cancelled by pressing Esc.

The region you want to copy something to, must, in most cases, be of the same
shape as the region you copy from, i.e.same number of rows by the same number of
columns. If this is not so, SAM will raise an error message. Also, there may be func-
tions in the right-click menu to enable you to perform functions globally on the
selected cells. These functions are specific to the particular view.
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55 Directories

The information stored by SAM is kept in different files and directories. To specify the
directories, click on Options in the menu bar and then click Directories to open a new
window labelled Configure.

Click Options  Click Directories
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FIG 5-6. Specifying the directories.

1. In SHOW, you keep the shows. Each show constitutes a directory containing all
files associated with that show.

2. In SETTINGS, you keep the operational settings like the ones you performed in
5.3 User Properties.

3. In BACK-UP, you can specify a different directory, drive or device for making
back-up copies of the show, user settings etc.

4. In USER you specify where User Setup files are stored.

In order to avoid affecting SAM'’s ability to find the required files associated with
Show or User Settings the next time you run SAM, be careful when changing these
directories.

5.6 Communications

5.6.1 Open communications

Setup Communication Ports
Consol
Driine / Dffine Tope Comms Parts
1 [ I [ 1sszezaza0 [ imzan Set Port
o [ [ [ GoL P
FIG 5-7. Specifying the directories. Cancel

In the dialog box in fig 5-7 enter the appropriate values in the boxes provided (see
Communications Setup in the Séance User Manual).
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5.6.2

Tracking

The Tracking feature allows a backup PC to run through its show file in step with the
main PC, so that in the rare event of a failure, the backup PC is already at the right
point in the show so that it can take over smoothly.

Tracking & Remote Control =
- Tracking
I Enable Tracking Stetus: | NotOpen | ¥

Mate - Both Sam Computers must have : Local Part; |01 E

- Tracking Enabled
- & setial connecting lzad on the appropicte ports
- 01 4 network connection

~ Remote Co

I Enable Remate Cantrol Stas: | NolOpen 98
B 3
2 Send Urly
© Rzl
@ Send k Feosive

Local Por: [Corz ]

Mote - Both Sam Computers must have :
- Remate Contral Enabled
- Send and Receive processing set [ both can not be Send Only |
- & setial connecting lzad on the appropicte ports
- or & network connection

| ancel

FIG 5-8. The Tracking feature dialog box

5.6.3

The system works by sending a message containing the Cue number via a serial
connection. The backup PC receives this message and moves its show cursors to
the relevant cue if it exists.

Tracking can operate through network connections. When Network is selected from
the Comms menu, an additional box appears into which you enter the IP-address of
the other computer. The IP-address of the current computer is shown at the bottom
of this box, thus making it easier to transfer IP-addresses between two computers.

Remote Control

The comms menu includes an option for remote control (see fig 5-8). Its function is
similar to that of the Tracking feature, but the controlled PC actually recalls the cue.
This enables two (possibly dissimilar) consoles to be controlled from one position by
remote controlling one as a slave. Since the function of this system is based on cue
numbers, the slave system does not have to have all the same cues as the Master
system. Messages received with a non-existent cue number will be ignored.

Remote control can be applied through network connections. When Network is
selected from the Comms menu, an additional box appears into which you enter the
IP-address of the other computer. The IP-address of the current computer is shown
at the bottom of this box, thus making it easier to transfer IP-addresses between two
computers.
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6.1

6.2

Opening and Saving shows

Open last show

When starting SAM, the program allows you to have the last show you were working
on automatically re-opened, (see 5.1 Start-up options). For a show to be opened, it
must first have been saved (see 6.3 Saving a show).

Open a new show

To open a new show, click on File in the menu bar and then click Open. A dialog box
opens.

Open a Show file EHE
= | A : — Preview
Lok jn: I@ MyShows j | rjzl |
Faders :
B Iy First Show Modulss -
= 5 ampleShaw odulles ©
FoH The new show Frames :
= the super show Tupe:
FoH ultimate show
Comment :

File name: | Open I
j Cancel |

Files of twpe: ISam Filez

1S

FIG 6-1. The Open show dialog box.

B Click on a show to highlight it and display information in the Preview part of the
window.
B Click twice on the show to open it or click on Open.

If the current show has been modified and not saved, SAM will warn you before
opening the new show.

All Windows® programs allow you to right-click an option and bring up a menu with
various file handling options, such as Send To, Delete, etc. Use these options with
care, since Windows® has no specific way of dealing with details of CADAC show
directories and therefore may alter a show in a way that makes it impossible to re-
open it.

Note that this window may display:

B SAM shows
B  CGC shows
m Directories

each of which is treated differently when double-clicked.
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6.3 Saving a show

You save shows using the Save or Save As... functions, available in the File menu.
Use Save for a show that already exists on the computer hard disk to update its
associated files with the latest information.

When you save a show for the first time, or save a show under a different name, you
use the Save As... function.

When you click Save As... a dialog box opens, see fig 6-2.

Click Save As...

EE Cadac Sound Automation Manager T1.04 : 24 - SampleShow - Working Dffline -

[Ble.

'TTT 5[ B[w o | B[

Save Show As

Enter show
and save

-

FIG 6-2. Using the Save As... function.

Enter the show name in the upper box in the window. Note that the name must com-
ply with Windows® rules for filenames. The bottom box is intended for a short,
descriptive comment, see the Comment area in the Open Show dialog box (see

fig 6-1). The middle part of the dialog box shows the console configuration.
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6.3.1 Backup Show

To make a backup of the current show, click on the File option in the Menu Bar and
then select Backup. A dialog box opens (see fig 6-3) prompting you to enter where
you want the backup to be stored, and which parts of the show/setup that you want to
include. If you do not wish to use the default directory (specified in Directories in the
Option menu) click on Browse to select another directory. When you have entered
your choices, simply click on Backup.

E’; Cadac Sound Automation Manager T1.04 : 24 - SampleShow - Working OFffline -
File Edit “iew QOptions Mode “Window Comms Help

dont. L8[ 5] 5[5 B|w 8 | 3]0 | wsdinese

Dpen Show...
Save Show
Save As

i
e __||pylnel| e B R v (g
:

Bestore Show
Export 3
Import »

Print Setup
Frint Preview
Print ...

Exit

I C:hMuShows\S ampleShow Browse |

Backup Ta:

| C:YFrogiam Files\Cadach Browse

¥ Shaw

Click on Backup Show I Console Map
™ 54M's Settings

Click on Backup L Wk S Ciahp || | Concel |

FIG 6-3. Backup Show dialog box

6.3.2 Restore Show

To restore a show, click on Browse and select the directory that contains the show
you want to restore. Then, by checking the relevant boxes in the dialog box, select
which parts of the show/setup you want to restore. Finally, restore the show to the
directory of your choice (specified in the Restore To box), by clicking on Restore.

f“"x Cadac Sound Automation Manager T1.04 : 24 - SampleShow - Working Offline -
File Edit ¥iew Options Mode Window Comms Help

Mew Show ||ﬂ1|ﬂ2|§ﬁulﬁﬁ|g|

| Bl | sosisese

DOpen Shaw...

Save Show

Save s -

Redap.. | F1 [ E2°| E3*[ ra [fse| 7o
— = ||| e ] |

Backup Show
poit
Import

Print Setup
Print Preview
Frint ...
Exit

Restore

Restore Show

I C:AMuS hows\ The new shaw Browse I

Restore To:
I i pShowsh Browse
‘ ¥ Show
. ™ Conzolz Map
Click on Restore Show [ SAM's Setings

Click Restore ) Bt Bestore Cencel_|

FIG 6-4. Restore Show dialog box
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6.4

6.5

Export and Import

Export and Import facilities using CSV-files (comma-separated variables) are avail-
able via the File menu for the console layout (map) and names assigned to each
module position. Try for example SAM’s export facility to see the format expected of
the file, after which you could use your favourite program to create a similar file to
import into SAM SETUP or SAM.

Show and console mapping conflict

If you try to load a show that has been saved with a different mapping than that of the
current console, SAM will display a dialog box labelled Show and Mapping conflict,
see figure 6-5. For details on the options in the dialog box, see sections 6.6 Load
from console, 6.7 Load from show and 6.8 Re-mapper.

Show and Conszole Mapping Conflict

. The Show being loaded was saved using different .
mappings and cannot be loaded directly into sam.

Flease chooze the type of conversion process required :

Load Fram Show Launch Retd apper Laad from Conzale
All mappings will be Femap any of the ch? dl tze Rl
extracted from the modules ar faders h EE mlto.t =
‘shows' mapping file. from the 'shows' map CONsalEs MAppngs.

inta the consale. Data may be lost !

Launch SamRetap Load from Conzole

FIG 6-5. The dialog box Show and Console mapping conflict.

6.6

Load from console

When a show is saved, the console configuration is saved as part of the Cue file.
This allows SAM to determine whether the saved configuration is different to the cur-
rent console. If it is, SAM re-arranges the data for the new console. The mapping
may not always be the same since different modules require different data, but this
method is usually much quicker than re-plotting the whole show from the beginning.
When re-mapping has been carried out, SAM indicates this in the title bar, see fig 6-
6 below.

In some cases, the show cannot be automatically translated into the current console

configuration. If this occurs, the option “Load from console” is greyed out (as in figure
6-5).

Console configuration re-mapped

‘EE Cadac Sound Automation Manager T1.05 : 06 - The new show == Modified Mappings == ___ [B[=] [E3

File Edit Yiew Options Mode Window Comme Help

FIG 6-6. Title bar indicating re-mapped console.
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6-5

6.7

6.8

6.8.1

Load from show

Use this option to override the current setup of SAM and to configure the console in
accordance with the mapping that is contained in the show file. This is a temporary
feature and SAM will revert to its original console layout next time it is run.

Re-mapper

SAM features a new function called the Re-Mapper. The Re-Mapper allows you to
re-organise (Re-Map) shows designed on one console to suit another console with
different modules. The Re-mapper can be invoked in two different ways:

B When opening a show, SAM detects that the Show configuration and its own
configuration are different and offers the Re-Mapper as one option to resolve the dif-

ference.

B Select Re-Mapper from the File->Remap... option.

Re-Map upon opening a Show

If the console configuration is different to that of a show, the Re-Mapper opens a dia-

log box that looks similar to figure 6-7.

SamAeMap T1.01 : 03

Module |
Fader |

Show Type Pos Conzale Type Pos Bad Links Mew Blank
Blark | Blank [o [o
Blank | Blank [o o
Zoom
i | Coriuait | iz | Dear | ﬂl ﬁlﬁl Conzale Fader Key

O Bad Link - Data Lost
O New Blank Data

O &vailable

O Converted

Markers

Conzole Module Key

[ Elank

W (7392E] Maono Chann
[ [7927] Mator Mona
[ (7324] Sterea Chani
[ [7325] Mator Stere
Wl (73955] Master Fader
[ [795E] Mator M aster

Hint |Se|ec:t SOURCE ltem to Remap and Press "Find" ar "Caonvert"
Show Links

Fader | Module “ Eoth

™ Shaw All Lirks

V' Show New Links

Save Links Load Links |

[ Blank -
[ (5307] Basic Che
W [749E] Dual Inpu
[ [7220) Dual Inpu
[ [72E5] Sterea Ch
[ (F302] Standard
Wl [7925] Programm
[ [7372] Programm
W (7974) DaclPFL
M (£309) Awsilliary C
M IFA1R1 PR bk LT

Cancel |
[ ok |

0k

FIG 6-7. Re-mapper opening dialog box.

The dialog box displays two rows of coloured blocks, similar to the row shown in
SamSetup. As in SamSetup, the coloured blocks represent the arrangement of fad-
ers and modules in a console. The top row represents the console that the show was
designed on (the “Show”) and the bottom row represents the present console config-
uration (the “Console”). On opening the show, SAM compares the two “maps” to
ensure that each position in each frame has the same type of module and fader for
both the Show and the Console. In this case, SAM indicates in the “Bad Links” and

“New Blank” boxes that there are differences.

A Bad Link indicates a fader or module in the Show that has no equivalent in the
Console. The data for the show module cannot be automatically transferred and so

will be lost.

A New Blank indicates a fader or module in the Console that does not have an
equivalent in the Show and so no data is available for it. Thus, it will be filled with
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“blank” data.

Bad Links and New Blanks usually occur in pairs, see fig 6-8. In the figure, nine non-
motorised faders, originally used in the Show, have been replaced with motorised
faders (the dark blue and light blue blocks in the Show and Console respectively).
The linking from Show to Console can be examined by ticking the box Show All
Links, see fig 6-8 .

SamHeMap T1.01 : 03 E3
Show Typpe Pos Conzale Tupe Pos Bad Links Mew Blank M arkers
Mockie | Blark | Blank [o [0 [rBadlik-Datalost
O New Blank Data
Fader | £ | £ [0 07 |osvaiatie
Zoom O Corverted
Eirid Ci b I ks (] H1| 2| ®3
i | SEKE | eke | ZiE | _I _I_I Congole Fader Key  Console Module Key

[ Blank. [ Blank

Wl (7936] Mono Chann
[ (7937] Motar Mona
[ (7934] Steren Chari
[ (7935) Motor Sterso
W (7955) Master Fadei
[ (7956) Motor Maste:

[ (5307] Basic Che
7436 Dual Inpu
7830) Dual Inpu
7865] Sterea Ch
E308) Standard

7925] Pragramm

7972 Pragramm
7974) Osc/PFL
B309] Availlary
RA1RI PR ME LT

Cancel |

[l
0
0
I
[l
0
[
(I
M1

Hint |Se|ec:t SOURCE ltem to Remap and Press "Find" ar "Convert"
Show Links

Fader | Module || Eath

V' Show &l Lirks
ul s

Save Links Load Links |

FIG 6-8. Position “linking”.

Each position has a “link line” drawn from the Show to the Console, some are cyan
and some are dark blue. Three buttons in the bottom left of the dialog box allow you
to examine links for Faders, Modules or (as above) Both.

SamAeMap T1.01 : 03

Show Type Pas Conzole Type Pos Bad Links Mew Blank Markers
Module | I i} - 0 Bad Link - Data Lost
O Mew Blank Data
Fader | ELnk | Blank (I 07 o bvaiatie
Zoom O Converted
Eitad 5 i w1 [ X1 K2| X3
i | o | Harz | e | _I _I_I Conzole Fader Key  Console Module Key

[ Blank

W [793E] Mono Chann
7937] Motor Mono
7934) Sterea Charni
7935) Motor Sterea
7955] Master Fader
795E] Motor M aster

[ Elank

[ (307] Basic Che
W [749E] Dual Inpu
[ (7220) Dual Inpu
[ (7265] Sterea Ch
[ (F302] Standard

W (7925] Programm
[ (7972] Programm
I (7574) Osc/PFL

[£909) Avilliary Dutpul
MTiFA1R1 PRk Mk [T

Cancel |

0
(Il
0
Il
0

Conzole
J Type

Hint |Se|ec:t SOURCE ltem to Remap and Press "Find" ar "Corvert"
V' Show Al Links

Show Links - .
Module Both Save Links Load Links | Sl Wz Lirbss

FIG 6-9. Fader links only.

Viewing just the fader links shows the changes. Since the Show used non-motorised
faders and the Console now has motorised faders, the first nine faders do not show
“link lines”.
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6.8.2

SamHeMap T1.01 : 03 E3

todule |
Fader |

Console
J Type

Creating Links

Once you have established where the Console differs from the Show you can convert
or translate the original show data to make it suitable for the replacement faders. This
translation will be more or less complete depending on which type of fader/module is
the source and which type is the target.

To create a link we perform the following steps:

B Select one or more faders/modules in the Show configuration by clicking on the
coloured box (-es) with the left mouse button. Shift-clicking and Ctrl-clicking may be
used to form multiple selections.

B In the Console configuration, click on the fader/module to which you wish to
make the link. In the case of multiple selection you only need to select the first fader/
module, the rest are implied by the size of the group selected in the Show.

NOTE: The linked fader/module does not have to be the one in the same frame posi-
tion. Clicking the button labelled Make will create the links.

When all the required links have been created, the Bad Links and New Blanks
counters show zero.

When all links have been made, click the OK button. SAM will run through the cues
of the show being opened and change the data as required to accommodate the new
modules.

Show Typpe Pos Conzale Tupe Pos Bad Links Mew Blank M arkers

0 Bad Link - Data Lost
O New Blank Data

Firad | [Eomvert | ke | [Elear, |

= o
= e

.
—

Blark | Blank

O &vailable
O Corverted

Congole Fader Key  Console Module Key

[ Elank [ Elank -
0l (7936) Mono Chann | | (§307) Basic Che
[ (7937) Motor Mono [7436] Dual Inpu
[ (7334) Stereo Char |0 (7830) Dual Inpu
[ (7335) Motar Stersa | (7865) Stereo Ch

[

[

[

[l (7955) Master Fade E308) Standard
[ (7956) Motor M aste 7925] Pragramm
7972 Pragramm
(7974) Dsc/PFL
[6309) Awilliary Dutpul
M RA1R1 PRk bk LT

i
0
0
0
i
0
[

Hint |Se|ec:t SOURCE ltem to Remap and Press "Find" ar "Convert"
Show Links

Module Eath Save Links

Load Links |

V' Show &l Lirks
™ Show New Links

Cancel

i

Ok

FIG 6-10. Selected faders, ready to make links.
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6.8.3

SamHeMap T1.01 : 03 E3

Re-Mapping a correctly configured console

Sometimes the map of the Show and the Console are identical but you wish to move
modules from one place in the frame to another. For example, you may wish to bring
the controls for one actor or instrument closer to the centre of the console. If you
move an actors microphone from say channel 1 at the extreme left of the console
and plug it into say channel 9 (near the middle) the recorded cue data for these
channels would be incorrect. With the Re-Mapper, you can move the data recorded
in the cues for channel 1 so that it is now recalled to channel 10.

The Re-Mapper dialog box opened by clicking File->ReMap... shows that all faders
and modules in the Show are linked to the corresponding fader/modules in the Con-
sole. You can however break links and remake them in a different order. Figure 6-9
shows channel 1 and channel 16 and also channel 2 and 51 linked to swap the data
This is a very simple example of what could be a very complex rearrangement proce-
dures

Show Typpe Pos Conzale Tupe Pos Bad Links Mew Blank M arkers

todule |

0 Bad Link - Data Lost

I L L

Fader 7] Mator Mono Channel F | 1/2 |7 Motar Mona Channel F | 1451

O New Blank Data
O &vailable
O Corverted

= =

Zoom

Find | Corvvert | ke | LClear |

Console
J Type

Congole Fader Key  Console Module Key

[ Blank. [ Blank -
[7936] Monao Chann | (6307) Basic Che
[7937] Motor Mono | |l [7496) Dual Inpu
I (7334) Steren Chanrel Fader]] Dual Inpu

[ (7935) Motor Sterea [[ [FEE5) Sterea Ch
W (7955) Master Fader |0 (5308] Standard
[ (7956) Motor Master [l] (7325] Programim
[7972] Programm
[

I

f

7974) Osc/PFL
B309] Availlary
RA1RI PR ME LT

Hint |Se|ec:t SOURCE ltem to Remap and Press "Find" ar "Convert"

I Fader Module Eath

V' Show &l Lirks

Show Links

Cancel |
Load Links | I™ Show New Links

Save Links

FIG 6-11. Moving faders/modules within a show.

6.8.4

6.8.5

Save and Load link files

If several different shows requires the same translation and the translation requires a
complex set of cross-links, saving the link-set as a file will make things easier and
save time. To save a link-set, click the Save Links button. Later you can reload this
link-set by clicking the Load Links button and thus, apply the rearrangement to
another show.

Translation and partial translation

In some cases, using the Make a link feature in the Re-Mapper, generates a brief
summary of the translation on the screen, see fig 6-12 opposite.

This report may give details of what has been translated and, more importantly, what
has not. It may be that an item that exists in the Show module does not have a corre-
sponding item in the destination module, thus resulting in the translation being only
partially done

Sound Automation Manager
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FIG 6-12. Translation report.

6.9

6.9.1

6.9.2

6.9.3

6.9.4

Convernt Fader / Module Types

— Details

~ltem 1

Module - [7496] Dual Input Channel Module to [78E5] Sterea Channel £ |
Corwert a Dual Input Channel to a Stereo Channel il

~End of List

What constitutes a show on the hard disk

When working in SAM, it may seem as though the show constitutes just one file,
since most of SAM’s functions treat it as such. From a technical point of view how-
ever, a show is a directory with many files in it, so when saving a show, SAM creates
a directory and saves various files into it. The simplest show has at least two files:
Showname.Cue and Sam.Cfg.

Showname.Cue

This file holds the list of static cues. A static cue is a cue that acts instantaneously;,
fader snap shots, MIDI, EVENTS etc. Backup-files are saved as *.BAK files.

Sam.Cfg

All show files contains this file. SAM uses it to distinguish between directories, so
that a certain directory can be recognised as being a show. The file contains general
configuration data, for example console size, MIDI and Event names.

*.MIX

Files containing information about dynamic mixes are stored as *.MIX files. The con-
tents of these files can be viewed using the DOS-utility WALK.EXE.

Opening a CGC-show

CGC-shows are saved in DOS-format and therefore have to be translated into an
appropriate form before SAM, operating under Windows®, can open them. In some
cases, this may result in an incomplete translation, which therefore requires the show
to be remapped for setup (see 6.8 Re-mapper).
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71

& Cadac Sound Automation Manager ¥1.07 - SampleShow - Working Difffine -

File Edit %iew Options Mode Window Comms Help

Viewing and editing the Cue
data

Opening the Data Editing windows

The cue data is displayed in various child windows, accessible via the toolbar at the
top of the SAM main window. The child windows containing fader and module data
are referred to as the frame windows.

There are as many windows available for the fader frames and module frames, as
there are frames in your console(s) as selected in SAM Setup. Each frame window
can be accessed by clicking the Console View button in the tool-bar - see fig 7-1
below.

O| =[] alup|2| 8]k

E=  |omee B2kl s v R0 C]

o |5 i e e |

v

1: J Type

2 o

i1 82 IEJ

T

B

FIG 7-1. SAM’s toolbar.

Console View

Module Frame View
Fader Frame View
Master Title Data Base View

In addition to the console view, there are views for MIDI, Events etc., see sections 8
MIDI features, 8.8 Events and 7.4 Naming the console modules. Each icon opens or
closes a window, displaying the associated data. The icon appears to be in a down
position when the window is open and raised when closed.
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f; Cadac Sound Automation Manager ¥1.07 - SampleShow - Working Offline -

Eile Edt Yiew Options Mode Window Comms Help

7.2 The Fader frame window(s)

To view fader data, click on one of the fader frame icons. This displays a fader frame
window with a picture of the console faders, see fig 7-2. Note that when SAM first
loads a show, the Cue window does not show the cursors. Press the PageDn key on
the keyboard to have the cursor move onto the first cue. The fader frame views can
then display the cue data.

e

Eo=  |omes B[aE 5 am vlE 0]

o | el

1: J Type
EREY
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1. Click on Console View

2. Click on the Fader frame icon 3. The Fader frame window opens

E’E Cadac Sound Automation Manager T1.05 : 06 - SampleShow - Working Difline -

File Edt “iew Options Mode ‘window Comms Help

D 3{u] afe k|| Blo(e] sl |wmese Blo|n] w818 H] ] 810
I
?__5'5 Fader Frame1 (1.00) Large Bang 9 [w] 3

FIG 7-2. The SAM toolbar and the fader frame view.

The types of faders and their positions in the frame are determined by the selections
in SAM Setup (see section 2 Set the console configuration).

When you recall a cue, the fader frame window and any other open window associ-
ated with the cue, will display the cue contents. The amount of data available
depends on the console type and the type of modules in it. Generally, the channel
faders have a VCA-group and switches for Mute and Aux. Some fader types have
more switches. In the case of motorised faders, the fader knob also changes position
to show the recorded level.

Left-clicking with the mouse over a fader selects that fader. A green icon with red
arrows above the fader indicates this. Shift-clicking or Ctrl-clicking selects further fad-
ers. Some data items can be entered directly using the quick keys, described in the
following section. More extensive editing can be performed through the Fader Detalil
window (see 7.2.1 The Fader detail window).
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7.21 The Fader detail window

If you double-click on the selected fader, a fader detail window opens.

Double-click on the fader

?__5'5 Cadac Sound Automation Manager T1.05 : 06 - SampleShow - Working Difline -

File Edit “iew Options Mode ‘window Comms Help
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FIG 7-3. The fader detail window. Click on functions to edit the cue

The Fader detail window offers a larger display of the faders. The associated controls
can be clicked or dragged to change the data.

In the fader detail window, you can:

Click and activate individual functions and see how the LEDs switch on and off.
Drag the fader knob to a new position.

Enter an alphanumeric title for each master fader in its associated Edit Box.
Use the Quick Keys to enter or change data items.

The facilities vary according to the console faders., They do however follow the same
style.

In circumstances where the destination of a key press is ambiguous e.g. a module
with several MUTE sections, individual items within the fader can be selected. The
item can then be selected and so receive the key presses.
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7.3 The Module Frame Windows

The facilities in the module frame windows are the same as those in the fader frame
windows, although the functions provided are usually significantly different. As far as
data is concerned, they are essentially on/off switches or rotary encoders.

ZE Cadac Sound Automation Manager T1.05 : 06 - SampleShow - Working Offfine -
Fle Edit Yiew Oplions Mode Window Comms Help
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Double/click on the module to
open the detail window

FIG 7-4. The Module frame window and the module detail window.

You can open the Module Frame views by clicking the Module Frame icon in the Con-
sole view, which is accessible via the toolbar (see fig 7-1).

If a potentiometer is programmable, then clicking and holding the mouse button will
open a “tool-tip” showing the value for the potentiometer. Dragging the mouse will
vary the value - up or to the left will increase, and down or to the right will decrease
the value. Moreover, if the potentiometer is of dual-gang type, then the left mouse
button varies the “upper gang”, while the right mouse button varies the “lower gang”.
The tool-tip can be locked to the potentiometers position or, alternatively, move with
the mouse. You can set this option in User Properties -> Edit Options.

Real-time updating may optionally function across all controls for all modules. If a
value is changed in the Current Cue, then it will automatically be sent to the console
as an update. If a control is dragged, then the transmission rate for messages can be
set according to the computers processing power. This option can be found in User
Properties -> Edit options.
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7.4

FIG 7-5. Module Name List

Naming the console modules

The module names list allows each module (channel, group etc.) to be given a name,
describing the Character, Actor, Instrument or Effect that is being processed.

£ Module Name List mEx)

Frame| Slot Sets Actor Character | Instrument Named H

1 1 [OOROO000 james Santa Claus

1 2 IOmROOOOo peter Elf #1

1 3 0000000 matiah brs Claus

1 4 OOOOOEOE wiox reverh

1 5 |[O000CEEE band revert

Sets

|A|los ﬂ v |Band [ ] ‘ J r | ﬂ I
|5 opranos ﬂ ¥ [Reveibs J Vo J i ﬂ r
[Terars ﬂ ¥ [Effects J Mo ﬂ ] ﬂ r
[Bass | Jzets o~ | | i
[v Enable Channel Setz | Disable Edit of Channel Sets Show Key

As many or as few Names needed can be added to the list by right-clicking over the
column headers and selecting New Module Name from a pop-up menu. Then, fill in
the Frame Number and Slot Number. Slot numbers start at 1 at the left hand side of
the frame and increment for each single width module space up to a maximum of 63
at the right hand side of the frame.

Alternatively, you can use the function “Collect Mappings” from the same menu. This
will create a Name for each slot in the console. Name column 1 will be filled in with
the default name, which then may be edited as required.

There are up to 8 names columns, so each module slot may have several aliases,
where, for instance, one actor plays several minor parts and each module/fader can
be assigned to a Set or Sets for grouped operations. See 7.5 Fader/Module Sets for
details.

The process of giving each channel a name that will be displayed in a tool-tip or sim-
ilarly appear on the screen may seem a bit tedious. However, the time put into this is
justified in that you now can assign the Module Names via a menu system in the
Master Title View. The named channels are then automatically assigned to the cor-
rect VCA group - see section 7.4.1 for details.

Revision SAM2005-2
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7.41

FIG 7-6. The name shown in a
tool-tip

FIG 7-7. Entering a channel name
as Title for DC Master 3

FIG 7-8. The ripple-through effect
of VCA assignment in faders.

Using the module names

The advantages of the Module Name List become obvious as you begin entering the
names for the VCA Master faders in the title DataBase view, for example: Channel 1
has been named Santa Claus and this name is then entered as the first title for DC
master #3. This is shown in the tool-tip appearing in the Frame view.

ll

Jiames:5anta Claus, Inf & |
e e

o]

The channel name can now be entered as a DC Master Title using the menu system
in FIG 7-7. Entering a channel name as Title for DC Master 3.

- {7956}..‘{7956}..|{7956}.. (7956).. | (F956) .. | (T956).. | (T95
; | I . -

= Clear
~+— CentreText

|| Re<CalRipple
| Assign Mame  » Actor I
Names List., Character Santa Claus

3

3
Instrument »|  EIf #1
SetMame »

- - [ .

When you have entered the DC master Title, channel 1 will automatically be
assigned to VCA Master 3. Of course, the ripple-through effect applied to the Master
Titles means that the VCA assignment will also ripple through in the Faders.

Mrs Claus

Clearing the DC Masters Title, using the menu CLEAR feature, will set the channel
VCA assignment to zero. It is worthwhile keeping in mind that there are User func-
tions that will apply or remove the Mute, when setting the VCA to, or, away from zero;
hence it should be clear how this feature can be a time-saver when building the Cue
structure for a show. Once the Module Names List has been set up, assigning VCA
settings to channels is just a matter of selecting a name from the list available in the
Master Title DataBase View.

NOTE: This feature only works when the text is entered and removed from the Mas-
ter Title cells, using the menu features. If you simply type the name in, or delete
using the backspace key; SAM won't be able to maintain the link between the mod-
ule Name and the VCA assignments. Consequently, any changes to the Real Text
names will revert them to Manual Text and they must be re-inserted from the Menu
List to get back the Auto assignment.
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FIG 7-9. The
Module Name
List

7.5 Fader/Module Sets
If the show contains several channels to which you are going to apply the same data,
you may find it useful to arrange the channels as sets and then apply the changes
collectively. This may be the case if, for instance, you have a large choir on stage split
into a male and a female part, further divided into baritones, tenors, sopranos and
altos. By assigning a number of channels to a set, you will save time when applying
data and also make sure that the same data will be applied throughout the set. To
this end, the Sound Automation Manager software features the option Channel Sets.
& Cadac Sound Automation Manages ¥1.07 - SampleShow - Working Dffline -
File Edit View Options Mode Window Comms Help
MEE @uﬂ|T®:|: il |
Click to open Module Name List View
B Module Name List =
| Frame Slot | Sets | Namel | Name2 | Name3 | Named | Name5 | Nameb | Name? | Name8 |
Sets
[sert W= [se5 | /[ EEE ][l T -
[5ez W [sew I [ B - = -
[5ets W= [ser = [ AT [eens -
[Gets @ [5es I~ [ - [ -
[V Enable Channel Sets ™ Disable Edit of Channel Sets Show Key |

FIG 7-10. Selected sets.

Enabling and Naming of the sets is performed in the Module Name List View. One
way to access this view is to click Open Module Name List view. You can also click
Consoles in the View menu of SAM. This will open the Console View, from which you
then select Module Frame View. Remember that the menu options vary with the dif-
ferent views, so when you click View in SAM’s menubar while in Module Frame View,
you will get access to the menu option Module Text.

Having used one of the above methods, the Module Name List window opens, see
figure 7-7 above. Next, tick the box “Enable Channel Sets” - each set can then be
enabled so that SAM only displays the sets you need. To enable a set, tick the box
next to the chosen set. You also can edit the names of a set by clicking in the text box
for the set and type in a suitable name.

The selected sets are indicated below the faders in the Fader frame View -
see fig 7-10).

;5 1:Fader Frame3 (1.00) [[7937) Motor Mono Channel Fader 75]

e

I W R

T

M4 B4 B R R (EAIEE:

M
I

M

(000NER

- (0000

1]

The members of a set are displayed as coloured tiles - see figure 7-10 above, which
contains eight sets. Each set has its own designated colour. To assign a channel to a
set, click on the tile of the appropriate set below the channel (or clicking it again to
cancel).

Once you have set up membership of the sets, you can quickly select the faders/
modules you want to work on. Right-clicking with the mouse on a set brings up a
menu, from which you can access further parameters, Select Set, Remove All from
Set and Show Key. The latter shows the colour and name for each set and is super-
imposed on other windows to assist your memory when using the sets.

NOTE: If the check box Disable Edit of Channel Sets in the Channel Sets dialog box
is ticked, the click selection will not have any effect.

Set names can be assigned to VCA Masters just like Module Names (see 7.4.1
Using the module names), further automating the process of setting the channel fad-
ers VCA groupings.
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7.6

Master Title Database View

To get an overall view of how the Master faders are allocated and when their settings
change during the show, use the Master Title Database view (see fig 7-11). This view
shows the text that will be displayed in the alpha-numeric display on each Master
Fader.

!I;lg Master Title [1.00] Large Bang (O] x] I

(7955) .. | (7355) .. | (7955)... | 7ass) (7955) .. (7955) ..

!JIII<I - - - - - -| - - 2

7.6.1

. _|[ 955 ][ [955)
Alphanumeric display ——— iim
Mute Mute Mute
Isn‘\:) Iso.‘:) Iso.\:)
. ® ® ®
l 10 w 10 w 10 0w
k] 5 5 -] L] 5
o—fl—o o—fl—0 o—fl—o
5 5 5 E 5 5
10 1w o w0 10 10
20 20 20 20 20 20
30 30 30 kL) 30 30
40 A0 40 40 40 A0
B0 B0 BO)|
* | ¥

Ripple-through feature

The Master Title Data Base view is one window that features CADAC's “ripple-
through” effect. This means that when you enter “Real Text” data for a Master Fader
in one cue, the data will be applied to the same fader in all the following cues up to
the next item of “Real Text". The “ripple-through” data is displayed in a different col-
our and if the “Real Text” entry is changed, all the subsequent “ripple-text” items will
change with it.

This means that you only have to enter Master Fader Titles where they change. SAM
will take care of the rest for you. The ripple-through items will be recalled to the con-
sole in the same fashion as Real Items.

If you want to stop the Ripple-through at a particular cue, then simply right-click on
the cell and select Clear - this will blank the cell and set the “Real Text” property.
Alternatively, Ripple-through may be extended by right-clicking on a cell and select
Force-ripple from the pop-up menu.
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2. Click on Edit Cue List

FIG 7-12. The Edit

7.7

7.71

® Edit Title List Al+T

Additional functions

A Cue contains various data relating to different features of the console. From time to
time, it may be necessary to edit the contents of one or more cues. The data to be
edited may be associated with Faders, Modules or Master Title as previously
described or MIDI and Events (see section 8).

The current view can be edited directly from the Edit-menu, or through double-click-
ing in the cue view, while those views that are not open can be called up from the
View menu. If you want to edit a Cue Title, Dynamic action or lists of these, then
select Edit in the menu bar of SAM'’s cue view.

1. Click on Edit

E’; Cadac Sound Automation Manager ¥1.07 - SampleShow - Working Offline -
File | Edit “iew Options Mode “Window Comms Help

Und A e

ST [ TE N Lo | s8] 2]
F1 FiEdo B
= EditTile T

Edit Dynamic Cirl+D
Edit Dynamic List Al+D

Cut Cue i
Copy Cue Ctrl+C
Easte ISt

Select All Cll+dy

Select Cue To Edit

3. Select Cue to edit —f=- ==

Perhaps you want to edit data in a cue without recalling the cue to the console. The
easiest way of doing this is through the Edit cursor, displaying Cue data in different
views in which the desired data can be edited (see 4.3.2 The Edit Cursor).

If you are working with the cursors locked, it will still be possible to look at the cue
data using the Edit menu function. This function provides a dialogue box with a list of
all the cues in the show, from which you can select the one to edit. Having made your
choice, the Active View will show the applicable data from the cue and “separate” it
from the actual show, thus enabling you to perform the editing. The view is recon-
nected to the current cue as soon as a cue recall function is executed.

NOTE: It is important to remember, that the Edit-menu reflects what View you are in,
i.e. different views have different menu options.

Global editing

Global editing allows you to change settings for one or more faders/modules in one
or more cues. The global editing process is three-fold:

B Selecting the data to be updated
B Selecting the faders/modules to be set
B Selecting the cues to which the editing should apply
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Programmable items

7.7.2

Selecting the data to be updated

To select Global editing, right-click in the fader frame view and select Global Update.
A window opens, reflecting the settings of the module and

cue you have right-clicked on, see fig 7-13. In the left-hand part of the window is a
picture of the fader/module. Any programmable item in the fader/module may be
selected for update.

Global Update x|

] todify Cues
1] Mute & & Edit Cue Orly
(=] AuxT ) = Selected Cues [ Cue Yiew |
&+ Iso " Cue Range
L Al Cues Total
5 Start Cue -
10 : I'I.DD-Lalge Bang j
s End Cue :
2 : |1.DD - Large Bang j
1
Sy — Modify Selected Faders
i ; In Frame : ’Tﬂ All Frames [
20 1
0 : Curmently Selected :
i 1 2 Total
;: o Fim: 1] 0 BN
&0 :
» | Tokal Items Selected -
=] _ Ypdats | Al |

FIG 7-13. The Global Update dialog box.

To select, you can either:

m  click items
B drag a bounding-box around items

The dialog box shows the total number of items selected.

To deselect, shift-click on the item.
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FIG 7-15. Selecting cues. Click Apply N e | e

7.7.3 Selecting the faders/modules to be set

You may select the faders/modules to be altered either before, or after you have
changed the data. To select, simply shift-click or draw a boundary box around the
faders/modules to be selected. Finally, click on Apply in the Global Update dialog box
to apply the changes, or click on Update to apply the changes and close the dialog
box.

E’E Cadac Sound Automation Manager T1.05 : 06 - SampleShow - Working Difline -
File Edt “iew Options Mode ‘window Comms Help

e B R - 2 & Fi | E2*| E3%| F4 | F5_| F6 E¥ [ F8

D s(@] sl i || Blo(e] sl |wmwse Blo|0] w818 ] 810
Open / Close Module Frame1 Vi |—“ - =

?__5'5 Fader Frame1 (1.00) Large Bang [[7937] Motor Mono Channel Fader B] _ O] x]

Global Update ]
-l ModfyCuss
& Edt Cus Only

" Selected Cues [ Cue View)

' Cue Range

€ &llCues Total
Start Cue

1.00 - Large Bang =

EndCue

1.00- Large Bang F

- Modity Selected Faders
=
InFrame: | 1 3 Al Frames [

Select faders/modules

Currertly Selected
Click Apply ot —tpese | g | [ooe |

Total

NOTE: If you wish to update faders/modules in more than one frame, the check box
All Frames in the Global Update dialog box must be ticked.

7.7.4 Selecting the cues

For safety reasons, the Global Update dialog box opens with the default setting of
Edit Cue Only. To select more than one cue, click on the option Selected Cues in the
dialog box and then CTRL-click in the Cue View on each individual cue to which you
wish to apply the changes. If you want to apply the changes to a range of cues, sim-
ply click on the option Cue Range and then select the start and end cues from the
drop-down menus in the dialog box.

=l ModibCues
Mu(e;;) & Edit Cue Only
Aur " Selected Cues [ Cue View
+ Isol £ Cue Range
o € Al Cues Totd
Stan Cue -
1.00 - Large Bang 5
End Cue:
1.00 - Large Bang -
3.00 5.00 Lights dovn ~ Modify Selected Faders
4.00 8.20 Curnains up i
5.00 Do something In Framme - "_j Al Frames [

Cunently Selected -
12
Fim: 79 1]
Tatal ltems Selected B

Total

Select cue(s)
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7.7.5

FIG 7-16. Cue Notes window

7.7.6

Cue Notes

In the menu bar, click on View and then click on Cue Notes. A new window will open,
see below.

E’E Cadac Sound Automation Manager T1.05 : 07 - SampleShow - Working Difline -

File Edit | View Options Mode ‘Window Comms Help

- Cue q—ql
Oje B e | e (T i
MIDI 3 2| F3* B 7
0 e A N | EI A EA |
Mgdule....
= Master Title
This ve g owi Includes Cue notes (a5 you can seel)

Toolbars 3

This window is called cue notes and can be used for the entry of notes, reminders or

significant data for any cue of your choice. If you right-click in the window, a menu
with further options will open.

Printing

Printing of the details of the grid-class views can be achieved by using the File->Print
option. Printer options are set using the standard File->Print Setup menu option. To
view the result before printing, use the File->Print Pre-view option.
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8 MIDI features

8.1 MIDI port mapping

CADAC's Sound Automation Manager (SAM) features 10 MIDI ports, designated A
to K (the letter ‘I’ is deliberately excluded, so as not to be confused with the cursor).
These ports are referred to as “virtual” MIDI-ports, since they are not representative
of any actual hardware. When SAM is first started up, the program searches the
computer to establish which MIDI-ports are available, for instance, those of computer
soundcards. The available ports are then listed alongside the CADAC console’s own
facilities as Physical Devices. The linking between virtual ports and physical devices
may then be set or changed, by opening the MIDI mapper dialog box.

Wi Mapper B

Cancel

The dialog box shows that SAM has allocated a default mapping between the first
four virtual ports and the four available physical devices. Consequently, anything
being programmed on port A, results in an output from the A socket on the console
CCM; anything programmed on MIDI port D will result in an output from the MPU401
interface on the PC (this being the MIDI output socket on a standard PC joystick con-
nector).

FIG 8-1. MIDI mapper dialog box

8.1.1 Advanced mapping features

A show can be designed using all of the 10 virtual MIDI ports available. This means
you can separate the data into logical blocks, each with its own purpose, for instance
triggering of sound effects, memory recall messages, machine control etc. Hence,
decisions on how the messages will be sent to the external equipment can be made
later. The reason for this is that more than one virtual port can be allocated to each
physical device and SAM will then perform the necessary MIDI merging.

FIG 8-2. Allocation of more than
one virtual port to a physical de-
vice.

The screen-shot above depicts a scenario where a show originally was designed for
a CADAC J-Type; and is now being performed using an R-Type, which has only one
MIDI output port. Alternatively, a scenario where all MIDI messages are being
directed out of the computer’s MIDI port(s) could be considered:

FIG 8-3. All MIDI messages are
being directed out of the comput-
ers MIDI port(s).
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8.2

FIG 8-4. The MIDI window.

Static MIDI data

Show data can be divided into two types; Static data and Dynamic data. Static data
acts instantaneously while the dynamic data acts over a period.

A static cue can contain MIDI data, which is therefore referred to as Static MIDI data.
Figure 8-4 shows a typical MIDI window.

= Midi O[]

Cue No Channel Name Port| Ch | On |Vel-On| Off |Vel Off CC Val-CCl
1.00 A A, 1 45 64 o o = o
1.10 = = = = = = = = =
3.00 Al A 1 = = 45 £4 = =
4.00 = = = = = = = = =
5.00 AR A, 5 = = = = 12 0
6.00 = = = = = = = = =
7.00 = = = = = = = = =
8.00 = = = = = = = = =
9.00 = = = = = = = = =
10.00 = = = = = = = = =

I [*]

When you recall a cue, the MIDI window will show the current cue with a coloured
horizontal bar (see fig 8-5 below).

&2 Midi (4.00] Curtains up

Cue No Channel Name Port| Ch | On [Vel-On| Off |Vel-Offf CC |Val-CC
1.00 Al A, 1 45 64 = = = =
1.10 = = = = = = = = =
3.00 Al A, 1 = = 45 64 = =
4.00 = = = = = = = = =
5.00 A A, 5 = = = = 12 0
6.00 = = = = = = = = =
7.00 = = = = = = = = =
8.00 = = = = = = = = =
9.00 = = = = = = = = =
10.00 = = = = = = = = =

] []

FIG 8-5. MIDI window showing data for the MIDI commands.

To enter MIDI data, start by assigning a port and a channel number for the MIDI com-
mand. With the cursors in locked mode, select a cue in the cue window (in unlocked
mode, select cue with the edit cursor); then open the MIDI window by clicking its icon
in the toolbar.
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1. Select the cue 2. Click the MIDI-icon
3. MIDI-window opens 4. Right-click line 5. Click Insert New

to open a menu

BMdi(1.00) laigeBang el

__ CramneiName [ port| o e o] off [verom] cc varce

FIG 8-6. Opening the MIDI window to enter data.

A new row is added. Enter a virtual port (A - K) in the column labelled Port, by dou-
ble-clicking on its entry box. After you have entered a port, press Enter on the key-
board. Repeat for channel number.

Double-click on entry box Double-click on entry box

&= Midi [1.00) Large Bang —’_’_'_

__ ChamelNams | Pon| ch | on |veton| ot |veror] cc |valc

-
-
-
.
-
-
-
.
-
lri
am

Select port and press Enter Type in channel number and press Enter

FIG 8-7. Select port and enter channel number. Press Enter or use the shift+arrow keys to move from cell to cell.
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FIG 8-8. Enter values for Note-ON and velocity.

FIG 8-9. Enter value for Note-OFF and velocity.

The port designation represents the virtual port which may be “mapped” to a physical
device as explained in section 8.1, whereas the channel number is a conceptual
number contained within the data transmitted.

To enter data for the MIDI commands, double-click in a suitable ‘cell’ in the grid of
data. If SAM has started editing - indicated by the cell being displayed with the high-
light background colour - then editing can continue by moving the target around the
cells, using the shift and arrow keys.

If a NOTE ON or NOTE OFF is entered, SAM will automatically set the velocity to 64
in accordance with the MIDI specification. This parameter can, of course, be edited
should this be required.

Double-click on entry box, type in a
value and press Enter

E‘E Midi (1.00]) Large Bang _ O] x|

Cue No Channel Name Port| Ch | On(|Vel-On| Off |Vel Off CC Val-CCl
1.00 Al A 1 45 B4 = - - -
1.10 = = = = = = = = =
3.00 Al A 1 = = 45 4 = =
4.00 = = = = = = = = =
5.00 A5 A 5 = = = = 12 0
6.00 = = = = = = = = =
7.00 = = = = = = = = =
8.00 = = = = = = = = =
9.00 = = = = = = = = =
10.00 = = = = = = = = =

CIm [

Double-click on entry box, type in a
value and press Enter

Double-click on entry box, type in a value and press Enter

E‘E Midi (1.00]) Large Bang _ O] x|

Cue No Channel Name Port| Ch | On |Vel-On| Off |Vel Off CC Val-CCl
1.00 Al A 1 45 64 = - - -
1.10 = = = = = = = = =
3.00 Al A 1 = = 45 4 = =
4.00 = = = = = = = = =
5.00 A5 A 5 = = = = 12 0
6.00 = = = = = = = = =
7.00 = = = = = = = = =
8.00 = = = = = = = = =
9.00 = = = = = = = = =
10.00 = = = = = = = = =

CIm [

Double-click on entry box,
type in a value and press Enter
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8.3

8.3.1

MIDI Program Change

Entering data for MIDI program change

You can use the MIDI program change function, for instance, to change the memory
settings on an external sound effects unit. This is done by sending MIDI commands
from the computer to the equipment you want to control.

Click on the icon MIDI Program Change to open the associated window, (see fig 8-
10). The first column shows the cue number and the rest of the columns show the
channels. There can be up to 16 channels on each port, the required port being
selected by clicking on the Tab at the top of the view. The data for a channel can be

between 0 — 127 (1 — 128 Japanese format)! and it refers to a memory number in the
unit you want to control. For instance, you may have an echo box which has five dif-
ferent types of echoes, numbered program 1 to program 5, stored in its memory. If
you want echo program number three on channel 1 in cue 1, double-click the box

Channel A1/Cue 1, type in 3 and press Enter?.

Continue to enter data into any of the other boxes in the same way; just double-click
the box and type in a number. Remember to press Enter to end editing or a shift+
arrow key to move to another cell. Note that the MIDI program change window fea-
tures a “ripple-through” effect (see 7.6.1 Ripple-through feature), meaning that all
subsequent boxes in the same column in which you enter your data, will get the
same data. If you, for instance, enter 123 for Cue 5.00/channel A3, all cues subse-
quent to this cue will get this value. This data (the ripple-through data) will be shown
in red as opposed to the first box, in which the text will be green.

& Cue

Cue No

Time

Cue Name Info X-Act |

1.00

Large Bang

1.10

10.00

Drum rall A Click on the icon for

3.00

5.00

Lights down

4.00

g.20

Curlains up

5.00

Do something

6.00

Program Change view

7.00

8.00

B =1 O S = P =) e Rl
1 |

9.00

10.00

= DI Progra ange - |0 x

Select a cue

Double-click data box, enter

data and press Enter

FIG 8-10. Enter Program change data. | L

PortA |PortB | PortC | PortD | PortE | PortF | PortG | PortH | Partd | Portk |

cueto a1 | A2 [ a3 | a4 | as | e | a7 | as | s | a0 | an1 | a2 | a3 | a1e | a1 | ate
1.00 : :
2.00
390~
300
5.00
6.00
7.00
.00
9.00
10.00
11.00
12.00
13.00 : . . .
14.00 a 2 - i UL
15.00
16.00

The text entered is referred to as “real data” and the automatic entries are referred to
as “ripple through data”. If you subsequently edit the “real data”, then the “ripple
through data” will change with it.

1. See section 8.3.2 USA or Japan format
2. Note that you may need to check the instruction manual for the MIDI-device to ensure that
the program number is the same as the Program Change number.
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8.3.2 USA or Japan format

The MIDI-program changes are issued using humbers 0 — 127. Unfortunate circum-
stances have created a situation where the Japanese standard uses the numbers 1
—128. The data values transmitted are still 0 — 127, but they are typed in and dis-
played as 1 — 128. This means, when you send a command from equipment using
US standard to equipment using Japanese standard, the digit O will be displayed as
1. The SAM naming facility for MIDI channels therefore includes a format setting
option to cater for this, see section 8.4 MIDI names.

8.4 MIDI names

To help you remember which equipment is being controlled by which MIDI-channel,
you can assign a name to each channel. Right-click over the column headers at the
top of the MIDI-window to open a menu with the option Set names. Click this option
to open a dialog box in which you can enter and edit channel names. On the right
hand side of the name column is a check box which you can check/uncheck depend-
ing on whether you communicate with Japanese standard based equipment (see
8.3.2 USA or Japan format).

Right-click on column Click names and fmt

tave Right
Move Left
Hide
Properties

B; MIDI Program Change

Check box for
Japanese format

Cue Ho

A2
A3
A4
A5
AB
A7
A
Al
A

1.00
1.10
3.00
4.00
5.00
6.00

G T B

Edit MIDI Information

Port F | Port G | Fort H | PortJ | Fort

-] - Part A IF'ortB | Port C | Part D | Pt
OEE

14

s

m

|| o | o | o | m | o &1

M arme Frat

[m)

=
—
b=l
=

41
82
23
24

Enter/edit
channel name

46
a7
]
49
10 Ja10
17 &t
12 Ja12
13 |a13
14 a14
15 |a15
16 |A16

[T N R« N & A N R
=
in

Click OK

I
E e o

FIG 8-11. Assignhing names to MIDI-channels.
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8.5

MIDI Machine Control

By using the MIDI Machine Control, you can have sound effects stored on a machine
using magnetic tape or other media and have them played back when required.

In order for the tape machine to be able to locate the sound effect, you have to spec-
ify where to look on the tape. You do this by telling the tape machine how long it has
to play to reach that part of the tape that carries the sound effect. The playing time is
measured in hours, minutes, seconds, frames and sub-frames. A frame is equal to 1/

25 of a second® and a sub-frame is 1/100 of a frame.

To locate a sound effect on the tape, you use the command Locate. Other com-
mands available are:

Play

Stop

Rewind

Fast Forward

& Machine Control -[o]
FPS: 25 M

Cue Ho Port | Command [} Hrs | Ming | Secs | Frms Subsl
1.00 0ff
1.10 [l
3.00 0ff
4.00 PLAY
5.00 FFwD
6.00 RwD
7.00 Locate
8.00 5TOP
9.00 0ff
10.00 orf
11.00 off

=

s ele|alele| | -]

R R S

FIG 8-12. The MIDI machine control window.

NOTE: For safety reasons,
implementation of MMC is
deliberately limited to these
commands. Please do not
hesitate to contact CADAC,
should you have any queries
about this.

In the case where you use more than one tape machine, you have to give each of
them a specific ID. The default value is 0 and the ID you assign to the machine is
usually dependent on whether the machine has been pre-programmed by the manu-
facturer for a certain value or can be programmed by the user.

Before you enter data for MIDI Machine Control, you have to specify the frame rate?,
(see fig 8-13 below). To enter data for MIDI Machine Control, double-click on the
entry boxes required.

Double-click port Specify time
Select frame rate

ﬁ; Machine Control
—
FPS:

Cue H Port | Command 1] Hrs Ming Sec4 Frms | Subs |
1.00 £ 0ff E E - e -
140 s Off - - - - -
3.00 3 off @

400 |\ & PLAY 0

5.00 \ & FFwD 0

6.00 \a RwD 0 -

7.00 3 Lopate 0 1 2 3 4 5
4.00 A sST0F 1]

9.00 A lij

10.00 & ff

11.00 A lij

FIG 8-13. Enter data for MIDI machine control. Select command Enter ID

3. Or 1/24th or 1/30th depending on the FPS standard.
4. This is only necessary if your machine is sensitive to frame numbers outside of the range for
its set standard. Most machines will sensibly locate to the nearest “legal” frame.

Revision SAM2005-2

Sound Automation Manager



8-8 MIDI features

8.6 MIDI SysEx View

The Sound Automation Manager has the capability of transmitting system exclusive
strings. To use this feature, just type in a string of of space separated hexadecimal
values and they will be sent out from the selected port.

Double-click in the columns to enter your data

N

[EE MIDI SysEx [1.00) =13
CueNo  Port /|/ Description | \QsEx Contral String |
1.00 < MMC Play Carmand FOF 0006 02 F7

200
3.00
4.00
5.00
6.00
7.00
8.00
9.00
10.00
11.00
12.00
13.00
14.00
15.00
16.00

FIG 8-14. The MIDI SysEx window

Although this feature is called the SysEx view, you can enter any values, such as
notes, controllers, etc., however it's more reasonable to do this through the MIDI
Data view. In the example above, a SysEx message will go out from port C, contain-
ing an MIDI Machine Control message (MMC). The program (SAM) does not check
for validity, so it is up to you to make sure the string is a valid MIDI-message.

When SAM transmits a MIDI-string, either from the sequence control, the MIDI
Machine Control view or the SysEx view, it uses a certain aspect of the Windows®
MIDI system which, unfortunately adds a bunch of extra data to the end of what SAM
sends. This may cause some degree of grief in that controller 64 (sustain) will be set
back to off for every channel, and also a Note Off is sent for any Note Ons that have
been sent. In most cases this data will be harmless, but if you're trying to turn a note
on and leave the note off for another sequence or use controller 64, this feature of
Windows will annoy you, to say the least. For the time being, we suggest using the
static MIDI data window or send the sequences via the CCM.

8.7 Dynamic MIDI data

Dynamic MIDI such as a MIDI-sequence is the function of playing files containing
MIDI data in real time. Replay of a MIDI sequence is triggered by a Cue Recall. A
MIDI sequence file (or files) can be attached to a Cue using the MIDI Sequence List
View. This View looks very much like the Cue List, but does, in addition, display all
the information pertaining to the MIDI sequences being used in the show.

Double-clicking over the Cue Name column will open the Cue Name dialog box so
that the Cue Name can be edited, but further cue editing must be done using the
Cue View.
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8.7.1

MIDI Sequence List

In the MIDI toolbar, click on the icon Seq List to open a new window.

. . ho
Click sequence list—{=
FH mipi Sequence List E]@
£
Cue No Attachment Time Enabled | Port | 3
1.00
2.00
3.00
4.00 » Trombone msf 18619 Enabled
» FrencHorn mst 18634 Enabled B

5.00

£ A0 i ["]

FIG 8-15. MIDI Sequence List

FIG 8-16. MIDI Sequence Attachment
dialog box

The MIDI Sequence List window opens

This window is in all essence identical to the other grid-class views. You may, for
example right-click on any header in the window which will then cause a menu to be
displayed. The options in this menu are rather self-explanatory, it may however be
worthwhile giving some attention to the menu option called Properties. When you
left-click on this option, a dialog box will open called View Properties. This dialog box
has 9 tabs, each enabling you to set a number of parameters such as background
colour, text colour, grid lines in addition to data for the items in the MIDI sequence
list. For more information on View Properties, see 5.4 View Properties.

If you double-click on any of the columns or rows (except for the cue name column)
in the MIDI Sequence List window a new dialog box opens, see below.

Cancel

FH mipi Sequence List E]@
g
Cue No Cue Name Attachment Time Enabled Port | 3
1.00
2.00
3.00
4.00 » Midi Sequence Attachment Dialog 186149 Enabled
» Cue: 400 186.34 Enahled B
5.00 Midi Port /
£ A0 / ["]
[Part.a (CoM Midi & DUt |
Midi Sequence Attachment
|c:\myshows\rlype sampleshowhscalel.msf j
i EEE Double-click to
Tempo open dialog box
I Use File Value j 120 bpm Time: 3010

The name of the attachment, playback time and status (enabled/disabled) will then
be indicated in the corresponding columns in the MIDI sequence list.
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8.7.2 MIDI Sequence attachment dialog box
The drop-down list in the upper part of the dialog box provides options for which MIDI
port the sequence will be played through, whereas the menu in the middle part of the
dialog box lists available MIDI sequences in the current show directory. If you want to
attach a MIDI sequence from another show or directory, click the Browse button
where upon a standard file selection dialog box will be displayed; you can then
search for and attach the required sequence.
NOTE: Beware of sequences stored on removable drives, since SAM records the
Path List as part of the show data (see fig 8-18). If you do attach a file stored on a
removable drive and then try to run the show without the removable drive present,
this will cause problems, since SAM will try to load the sequence and run it.
8.7.3 Merging of MIDI sequences
Multiple sequences can be attached to a single cue; they will then begin playing
simultaneously. However, individual sequences may be stopped, using the little Stop
button above the sequence icons which appear in the MIDI sequence List View.
—@ MIDI Sequence List g@-
Cue No Cue Name Attachment Time Enabled Port B
1.00
2.00
3.00
4.00 » Trormbone. msf 18619 Enabled A
» FrencHorm mst 16634 Enabled B
5.00 |
£ nn )

FIG 8-17. Merging of MIDI sequences

Where several sequences are targeted at one single MIDI port; they will be merged.
These sequences may have been attached to the same cue (reconstructing a multi-
track MIDI file) and hence been started simultaneously, alternatively attached to dif-
ferent cues and started at different times. In either case, SAM will handle the merg-
ing in the background.

PLEASE NOTE: Merging of MIDI sequences is not available through MIDI ports on
earlier CCMs. Only the CADAC R-Type CCM is capable of handling multiple
sequences (maximum of four). The best way to get around this is to use the PC MIDI
ports where extensive usage of this feature is required.
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8.7.4

MIDI sequence control

MIDI-files are normally stored in the same folder as the one containing the show.
When you want to record a MIDI-sequence, click on the MIDI Ctrl option in the SAM
toolbar. This will cause the MIDI sequence control window to open.

Click on Seq Ctrl

E’; Cadac Sound Automation Manager ¥1.06 - SampleShow - Working Difline -
File Edit Wiew Options Mode “Window Comms Help

| =[] afs 8|8 | B

F1 | E2°| E3*| £ | F5 | F6
4 &E-‘l | | |

[REEE R = wmwese

==
i o

Afa[n EEY)
Sequence Control

 Playback
Port:

[Pt 4 (CCH Widi & Dut) |

Tempo:
= Pl 5t
22 bom | w

File:
|

- Fecord
Part:
CCM Midi 4 In =

The MIDI sequence control window opens

FIG 8-18. The MIDI sequence control window

To record a MIDI-sequence, type in the desired filename or use the Browse button,
should you wish to overwrite an existing file. Then press Rec in the MIDI Sequence
control window. You may at this point playback a MIDI-sequence into the console or
PC port selected, where it will be time-stamped and recorded. Note that time will
start at zero when the first MIDI event is received.

When you have finished recording the MIDI sequence, click Stop and the sequence
will be saved in the specified file.

To play back your recording, first open the file that contains the sequence (click on
Browse in the Playback section to find the folder) then click on Play in the control win-
dow.
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8.7.5

Converting a standard MIDI sequence

Most software sequencers can save or export a “standard MIDI-file”. SAM cannot
use these files directly but has the ability to convert them to its own native MSF-for-
mat. If you would like to attach a standard MIDI-file with the file extension *.mid to

any cue, proceed as follows:

1. Double click on the attachment field
for the required cue number

2. The MIDI sequence
Attachment Dialog opens

?__5'5 Cadac Sound Automation Manager T1.05 : D7 - SampleShow - Working Dffline -
File Edit “iew Option: Mode Window Comms Help
o - 8
0| || 2o |5 || Ble |08 |wmese Bl & [
E7 || FB 4| E0 Y L7 ? F1 | E2*| E3*l'F4 | F5*| 6
L] N\lﬁn i EB'}E | = | ¢ |G E-l :{— |
E2 MIDI Sequence List _ O] =]
Cue No Cue Hame Attachment Time Enahbled |
1.00 Large Bang
200 Dirurmn roll
3.00 Lights down Timpani.msf 186.61 Enabled
4.00 Curtains up
5.00 Do something
6.00
7.00
ann
M Seauonce Allachment Diaog £ o
Cue: 4.00: Curtains up o Laok jn: I@ SampleShow j ﬁl
Midi Sequence Attachment —_— Piceola.msf stuartuy.msf Thunderbirds.mid Trumpet.m
|<Nune> j Please.msf Testl.mst Timpari.msf Tuba.mst
Sam msf Test2 msf track1.msf wiight. maf
[" Enable  Time  0.00 Bl [#] GC88.msf ] Testz mef 8] track18.msf
m Sequenced msf Thanks.mst track31.msf
ShringsHi msf theme. msf Trainpas msf
0 P
Cancel Strngsdid.msf Thunder.msf Trombone.msf
L U v I 0|
‘ File name: L DOpen I
3. Click on Browse and  Fiessitpe: [Mid i msf o | ool |
H VA

FIG 8-19. Converting to MSF-format

select the folder that
contains the file you
want to convert

4. Click on the file you want

to convert

@ Convert file o Msf farmat 2
] he

6. Click Yes

5. Click Open

Having followed the procedure described above, you will be presented with another
dialog-box that requests you to confirm the conversion (see below):

MidiConverter

Widi File: to Convert :

Ilhundelhirds mid

Status: Ready

Mumber of Tracks : 0
Farmat : 0
Division 0

Files Extracted :

Browse !

MidiConverter

Widi File: to Convert :
Ilhundelhirds mid

Status: Ok

Murnber of Tracks: 32
Fommat : 1
Division 384 ppgn

Files Extracted :

Erowse

[#-J) tackl.msf
Timpani. msf
Contrabas. msf
Stingshid.msf
StringsHi.msf
FrencHorrmsf
Tuba.msf
Big.msf
Trombone.msf
Trumpel.msf
Percussio.msf
MuteT rmpt.msf
Saw.msf

= F iRl bRl bl bl

[

f: Cancel

Click on Convert

=IG 8-20. Confirming conversion

f: Cancel

A new window opens showing all the

extracted files in the converted file
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FIG 8-21. The Events window.

MIDI-files will generally contain a number of “tracks”, each containing a musical
sequence. These tracks are normally played back simultaneously, however, in the-
atre sound effects, each track is more likely to contain a separate sound effect
sequence. SAM will convert each track into a separate MSF-file which then will be
displayed as shown in the bottom right window in fig. 8-19. Clicking on the plus-sign
to the left of the file name will expand each branch of the tree thereby providing
details of each MSF file generated.

Following file conversion, any one of the MSF-files can be attached to the relevant
cue.Clicking once on one particular MSF file will highlight that file and the OK button
will be enabled. Clicking OK then closes the window and inserts the name of the
selected file into the Attachment text box in the MIDI sequence list. Note that, even if
you cancel the attachment to a cue, the MSF-files will have been created and kept on
your disk storage.

If all tracks in a MIDI file are to be combined to one MSF file, then save the MID file

from your sequencer as a “Type @” MIDI file - see the MIDI specification for details
regarding Type @ and Type 1 files.

Events

The console CCM contains 8 relays that can be user designated. An event can be
defined as the state of a relay. The state can be Off, On or Pulse. The relays can be
programmed to change state when a cue is recalled.

Events are used to control external equipment such as CDs, sample players, effect
units etc. At present, most CADAC consoles are equipped with 8 event relays.

Click the Events icon in the toolbar to open the Events window.

File Edit “iew QOptions Mode ‘Window Comms Help
| =8| [t |8 [ 2|8 Bl |e| B3k

Click the events icon

a; Event [1.00] Large Bang =13
cueo 1 | 2 | 3 | 4« | 5 | 6 | 7 | 8 |

100 [ N | Right

1.01 (—— o] Off off 0 Movelek

1.10 ff O Off off off 0 Hide

1.11 Off  Pulse Off Off Off 0 Propeties

1.20 Off off s off off g i I
= Il

Left-click the event Click option Right-click the header
to change the data to show a menu

In the Event window, the current cue is the cue you have highlighted with the edit cur-
Sor.

To change data in the event window, you left-click on the event in the column you
want to change. Each click with the mouse increments the data to its next choice (the
order being Off-On-Pulse-Off).

If you are not using a mouse, press ctrl + 1 to go through the selections for
event 1, ctrl + 2 for event 2 etc.

Click on properties on the popup menu to arrange column headers vertically or hori-
zontally. This menu also contains options for moving the column right/left or Hide.
For information on the Properties option, see 8.7.1, on the next page.
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8.8.1

Event names

You can give each event a name by right-clicking over the events window to display a
menu. Select Properties in the menu to open a dialog box allowing you to enter and
edit the names. When the show is saved, these names will automatically be saved
with it and then appear as ToolTips in the main window.

&% Event [1.00) Large Bang _ O] x|

cueo 1 | 2| s | & | 5 | 6 | 7 | 8 |
o ———————
101 of | of of off off oft off off
1 ff | Pusd | Of off ot o of o
T MoveRight  og off off off off off off
T Moveleh off of off of off of of | o
Hide I
Froperties

Click Properties

to open a dialog box

FIG 8-22. Edit event names.

Left-click the header
to open a menu

View Properlies ]
FrogiamChange | Machine Contol | Midi | Cuehoes |

Alviews | Cue Evert | MaserTile

Column |tems
Sho:

¥ Show Raw Lines
J7 Show Colurn Lines
I™ Vertical Cell Header

0 =] Font Sice o1

Name:

ok | e | s | Her |

Click column to change name
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_ l Evert: PULSE
Selectitemtobe | ] Machire Contral: STOF Cancel |
indicated B Machire Cortral : PLAY

Enable feature —— ¥ Enable Indicators in Cue Yiew

X-Act Indicators

When a show is being performed, the sound engineer may require a quick and relia-
ble indication of events and data transfer (External actions) that will take place next.
This applies particularly to commands issued by the Automation System to

external equipment through MIDI or relay closures. A visual representation of these
External Actions can be made available in the Cue View by enabling the X-Act
(External Action Indicators) column. Select X-Act Indicators from the Options menu
to open the control dialog box in fig 8-23.

External Action Indicator Setup

Select Event/D ata type to Monitor
[ Event: QN

O Machine Contral : FFRWD
O R Machine Cantral : ROMW

[l Machine Cantral : LOCATE
OQ Midi Frogram Change : PC
O@ Midi Cantraller Change : CC
O[Q MidiMate : OM (Ary)

OO @ Hidi Mote : OFF [Any)

FIG 8-23. External Action Indicator Setup

In the dialog box, the individual items to be indicated in the Cue View may be
selected by clicking the associated check boxes. The overall X-Act column can also
be turned ON/OFF from this dialog box.

The X-Act Indicators, reflecting the choices that have been made in the dialog box,
appear in a new column at the right-hand side of the Cue View window. They are dis-

played as small blocks, each with its own designated colour.

The X-Act Indicator column

& Cue =] e
Cue No Time Cue Name Info ‘ X-Act |
1.00 Large Bang
1.10 10.00 Drurn roll
3.00 500 Ligghts down b
4.00 8.20 Curtains up o
5.00 Do something
6.00
7.00
8.00
9.00
10.00

FIG 8-24. The X-Act Indicator column

If you want to check exactly what action is to be taking place, then just hover over the
desired indicator. This will cause a ToolTip, describing the action, to appear.
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9.1

9.1.1

Dynamic Cues

Definition

A cue can define a set of fixed fader positions. A cue, however, may contain a
dynamic mix, which by definition is a set of fader movements performed while the

cue containing that mix is active®. Other names for a dynamic mix are dynamic files,
dynamic mix files or just mixes. Technically, a mix is a file stored on the computer
hard disk containing information on how the motorised faders will move or change
with time.

Recording a Mix

When you recall a cue, the Record Enable button in the tool bar becomes active.
Click this button to open the Dynamic Record Time window and to activate the Start
Record button. When the window opens, the time display is green and no counting
takes place. When you press Record Start, the display changes to red indicating
recording can begin. If the fader is in ready mode any of the following: fader move-
ment, mute set/clear or group change will initiate recording and the time Dynamic
Record Time window will commence counting.

Click record enable Dynamic Record Time window opens

Dynamic Record Time

E’E Cadac Sound Automation Manager T1.05 : 06 - SampleShow - Working Difline -
File Edt “iew Options Mode ‘window Comms Help 00 . 00 0
3| ]| [5 8]8B[0 |2 [[:: [msesn| B[s]a] Hls
A EACEE | nlglslm el
&E Cue 10| x|
Cue NHo Cue Hame Time Info X-Act
Dirum rall 10.00 [0}
Lights down 500 53] [ ]
Curtains up 8.20 (L]
Do something 00}
]
o
1]
]

Start Record button becomes active

FIG 9-1. Recording a dynamic mix.

SAM now records any movement of Record Enabled faders/activated mute buttons/
group assignments until the Stop Record button is pressed. The resulting mix-file will
be attached to the current cue and a time value will be displayed in the time column
of the cue window. An icon indicating that the cue has a dynamic mix attached to it
will be displayed in the info column.

1. Note that a dynamic file/mix cannot be defined unless the show has been given a name.
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FIG 9-2. Replaying a dynamic mix.

9.1.2 Replaying a Mix
If a cue has a Mix-file attached to it, which is indicated by the icon in the info column
of the cue window, you can replay the mix when the cue is recalled. The cue can be
recalled either from the CCM in the console or by clicking the icon in the toolbar. It is
possible to have SAM auto-start the mix as the cue is recalled. For this to happen,
tick the box in the Dynamic Edit Dialog Box (see fig 9-3).
When you replay a mix, the data on the hard disk is sent back to the faders/mute
functions/group assignments in correct order and at the correct time. The faders/
mute functions/group assignments will then reproduce the actions originally per-
formed by the operator.
Blue bar indicating Icon indicating Dynamic
progress of Dyna‘lmic is attached to cue
\
& Cue =] B3
Cue No Time Cue Name Info X-Act |

1.00 Large Bang

1.10 10.00 Drum rall £

3.00 5.00 Lights down 53

4.00 8.20 —_—E

5.00 Do samething

6.00

7.00

8.00

9.00

40 nn

9.1.3

Duration of
dynamic mix

A coloured horizontal bar along the name field in the cue window indicates the
progress of the mix. Some of the buttons in the tool bar will also become active to
allow the commands Pause/Continue/Stop to be issued.

Editing a Mix
You can edit an existing Mix by:

B Recalling the cue
B Setting Record Enabled via the icon in the toolbar
B Then starting playing the mix.

Any movement of Record Enabled faders/set mute/group assignment functions will
be translated into data and merged into the existing mix-file. The result will be stored
as a new file attached to the same cue. The previous mix-file will be moved one step
down the mix tree (see fig 9-3) from where it may be retrieved later if required.
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9.2 The Mix tree

When you record a mix, the data is attached to a cue and the previous mix (if any) is
moved to a list specific for that cue. Over time, the list builds up a history of mixes for
that cue, called the Mix tree. By double-clicking the left mouse button over the Time
or Info columns of the cue window, you can open a dialog box in which you can access
the control functions associated with the mixes (see fig 9-3 below).

1M =] B3
Cue No Time Cue Name Info X-Act |
1.00 Large Bang
1.10 1000 Drumn roll Ve
3.00 5.00 Lights dowen 52
4.00 B.20 Curtains up i
5.00 Do something
6.00
.00
Dynamic Edit for Cue 3.00
~ Step
™ Enable Step time to next cue I 0.0 Secs @
I Erebe NomSequenial Cuedune [ 00 coe [ Double-click the Time
or Info column
i Dynamic Mix Filz
_ | 1
C|Ick tO | Etostart Duration

auto-start cue

[~ Enable Edit i File:

i~ # - Fade Control
Profile Fade Up I 00 Secs
[ Enable JLooorimic ] FadeDown[ ™ 00 Secs

—+— Dialog box opens

— MIDI Seguence
| IE]

= Tiurzate ot Start Duration

" Enable Edit Sequence

Cancel

Click to add/edit comment

FIG 9-3. Control functions associated with the mixes.

The filename of the current mix is shown in the long text box. To view the history of
mixes for the cue, click the down arrow on the right hand side of the text box. High-
light any entry in the list and click on it to retrieve it, thereby making it the current mix.

To edit “user comment”, click on the Edit Mix File button. Use this feature to give
each mix a title describing what it does.

The Edit Dynamic window can also be accessed by clicking on Edit in the File bar
and then select Edit Dynamic, provided that the cue is selected with the Edit Cursor
in the cue window. If it is not, click on Edit Dynamic List in the Edit menu and then
select the cue.
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9.3 Recalling Static Cues while a mix is playing
While a dynamic mix is being replayed, it is possible to recall a static cue. You can
either choose to go on to the next sequential cue, see fig 9-4, or perform a non-
sequential jump to the cue of your choice.

Dynamic mix being played Static cue recalled while
dynamic mix is played
EECue 1M =] B3
Cue No Time Cue Name Info X-Act |
1.00 Large Bang
1.10 10.00 Drum rall i
3.00 5.00 Lights dawn
4.00 8.20 — e o |
5.00 Do something ‘
6.00
7.00
8.00

FIG 9-4. Recalling a static cue while a dynamic mix is being played.

To recall the next static cue while a dynamic mix is being played as part of the current
cue, you simply press PageDn, which will recall the next cue in the cue list. If you
want to recall a cue from somewhere else in the list, press shift + F3 and enter the
number of the cue required in the dialog box displayed.

9.4 Replaying two overlapping mixes
If you have two consecutive cues with dynamic mixes attached to them and you want
them to overlap each other, simply press PageDn to go to the next cue. The first
dynamic will continue to play and second dynamic will begin playing immediately,
provided the Auto-start feature is enabled or when you click on the play button in the
toolbar. Pressing F11 will have the same effect?.
If the next dynamic is held in a cue, not immediately following the one holding
dynamic A, press Shift + F3 to specify the required cue number.
B Cue = =] E3
Cue No Time Cue Hame Info X-Act |

1.00 Large Bang

1.10 10.00 Drum rall =

3.00 5.00 Lights down 53]

4.00 8.20 —Mainz up ]

5.00 460 Crosarmething

6.00

7.00

.00

9.00

4n nn

FIG 9-5. Replaying
two overlapping mixes. Dynamic mix A Dynamic mix B

The bars in the Cue name column indicate the progress of the dynamics.

2. Inthe instance where a second dynamic is enabled, it is considered to be Dynamic B. Func-
tion keys F10 and F11 provides a second set of Start/Stop and Pause/Continue buttons.
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Dynamic Cues

9-5

9.5

— Step
Enable Step Time ¥ Enable Step time to next cug I 0.0 Secs @
Enable non-sequential

cue jump

FIG 9-6. The step functions.

The step time feature

In the Dynamic Edit window shown below, there is a check box for enabling the step
time feature. Tick this box and enter a time value in the box on the right labelled Step
time to next cue. This value determines when the current cue will change to the next
sequential cue.

Enter cue for, . Enter time
non-sequential jump  in seconds

Dynamic Edit for Cue 1.00

—| Enable Mon-Sequential Cue Jump 0o Cue @

— Dynamic Mix File

1) C_000006 : User Comment (10.00] - D]
W &utoStart Duration
[ Enable Ediit Mix File | | Omins, 10.0 secs
— # - Fade Cantrol
Profile FadeUp| 00 gecs

™ Enable ILogarithmic vl FadeDownI 0o Secs

— MIDI Sequence
| I

= | Truricate st Start Duration

[~ Enable EditSequencel I
o

You can also have the program perform a non-sequential cue jump, which is to say it
allows you to jump from one cue to any other cue of your choice. To do this, first you
enable the non-sequential cue jump feature (see fig 9-6 above). Then, in the box to

the right, you enter the number of the cue to which you want the non-sequential jump
to take place.
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9-6 Dynamic Cues

9.6 Cross fade control

A dynamic mix may sometimes be as simple as to move faders from one position to
another in a given amount of time. Rather than to go through the trouble of creating a
mix file, you can use the Cross-Fade feature to make this operation easier. You will
find the cross-fade control in the Dynamic Editing dialog box.

If you want to use the cross fade feature, tick the enable box and enter a time value in
each of the boxes provided. Note that you may wish to have a different time for faders
moving up and for faders moving down.

Dynamic Edit for Cue 2.00
— Step

[~ Enable Step time to nest cue I 0.0 Secs @
= Enatile Mon-Sequential Cue Jump I 0o Cue E

— Dynamic Mix File
| -] D

= | etaStart Duration

— Enahle Edit i File ||

— # - Fade Contral

Prafile Fade Lp | 00 Gecs
ILongic;, Fade Down I_W Secs
— MIDI Sequence
| H

I iiireate &t Star

D
[~ Enable EdilSECIUBnCel I
Cancel |

Tick Enable

ration

Set time values

FIG 9-7. The Cross-fade function.

An icon will be displayed in the Info column of the Cue window to indicate the pres-
ence of the cross fade. When the cue is recalled, a time bar will be displayed in the
cue name field to indicate its progress.

Cross-fades normally works so that one cue in the show holds the starting position
and the following cue (programmed as described above) holds the ending position. If
you, however, move the faders in the console between recalling these cues, the
cross-fade will be calculated in real time, based on the actual position of the faders.

NOTE: The Cross-fade feature is applied to ALL of the faders, in all
frames in the console.
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Index

Symbols

* BAK 6-9
*.Cue 6-9
* MIX 6-9

A

Add User 5-2
Adding a new cue 4-7
alphanumeric title 7-3

B

back-up copies of the show 5-6
Backup Show 6-3
Bad Link 6-5

C

CGC shows 6-1

Child Windows 3-2

Click drag 3-3

Communicating with the console 1-2
Computer requirements 1-1
Configuring the frame 2-3
Context sensitive menus 3-4
control external equipment 8-13
Converting a MIDI sequence 8-12
Copy 4-13

Creating a new show 4-4
Creating Links 6-7

Citrl click 3-3

Cue Cursors 4-2

cue name 4-1

cue number 4-1

Cue Window 4-1

cue with a # in the cue number column 4-7

Current Cue cursor 4-2, 4-3

Cursor response to console commands 4-4

Cut 4-13
Cut, Copy and Paste 4-13

D

Deleting cues 4-11

Directories 5-6

Double click 3-3

Drag the fader knob 7-3

Dynamic Cues 9-1

Dynamic Record Time window 9-1

E

Edit Cue Cursor 4-2

Edit Cursor 4-3

edit the cue title 4-11

Edit Title List 4-11

Editing a Mix 9-2

Editing the cue name 4-11

Entering a channel name as a DC Master Title 7-6

Ethernet hardware 1-2

Revision SAM2005-2

Sound Automation Manager



INDEX-2

Event names 8-14

Events 8-13

Exporting a console configuration 2-6
External actions 8-15

F

Fader detail window 7-3
Fader frame(s) 7-2
Frame configuration 2-3
Function keys 3-3

G

Get Maps 2-10
Grid Class Views 5-5

H

history of mixes for a cue 9-3

Importing a console configuration 2-5
Insert 4-7

insert a new cue 4-7

Installing from CD-ROM 1-1
Installing from Floppy Disc 1-2

L

Last User Settings 5-1

Left click 3-3

Load Links 6-8

Locate 8-7

Lock Views 3-2

locked cursors 4-4

Locking and unlocking the cursors 4-2

M

Map file 2-5
Mapping 6-4
conflict 6-4
Load from console 6-4
Load from show 6-5
Maste Title Database View 7-8
Master faders 7-8
Menu Bar 3-2
MIDI
Advanced mapping features 8-1
Converting a standard MIDI sequence 8-12
Dynamic MIDI data 8-8
Features 8-1
Machine Control 8-7
Merging of MIDI sequences 8-10
MIDI data 8-2
names 8-6
port mapping 8-1
Program Change 8-5
ripple-through 8-5
Sequence attachment dialog box 8-10
sequence control 8-11
Sequence List 8-9
SysEx View 8-8
USA or Japan format 8-6
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virtual ports 8-1
MIDI data 8-2
MIDI Machine Control 8-7
MIDI names 8-6
MIDI Program Change 8-5
MIDI sequence control 8-11
MIDI Sequence List 8-9
MIDI-message valid 8-8
Mix tree 9-3
Module Frame Windows 7-4
Module Names 7-5
module names list 7-5
Mouse Pointer Shape 3-4
Moving cues in the Cue window 4-9
Moving cues using Cut and Paste 4-10

N

Naming the console modules 7-5
New Blank 6-5

New User 5-2

non-sequential cue jump 9-5
Number of frames 2-2

@)

Open a new show 6-1
Open last show 6-1
Opening a CGC-show 6-9
operational settings 5-6
Options menu 5-1
overlapping mixes 9-4

P

PageDn key 7-2

Parent Window 3-2

Paste 4-13

picture of the console faders 7-2
programmable 7-4
programmable potentiometer 7-4
Put Maps 2-10

R

Readme file 1-3

Real-time updating 7-4

Recalling a cue 4-6

Recalling static cues while a mix is playing 9-4
Record Enable 9-1

Record Enabled faders 9-2

Record Start 9-1

Recording a Mix 9-1

Redo 4-12

relays 8-13

Reload last show 5-1

Reload Windows Placement 5-1

Re-mapper 6-5

Re-Mapping a correctly configured console 6-8
Renumbering cues 4-8

Replaying a Mix 9-2

Restore Show 6-3

Right click 3-3

Ripple-through 7-8

ripple-through effect of VCA assignment in faders 7-6
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Sam Configuration 2-1

Sam Setup 2-9

Sam.Cfg 6-9

SamSetup 2-1

Save 6-2

save a console configuration 2-6
Save As 6-2

Save Links 6-8

Saving a frame configuration 2-4
Saving a show 6-2

Saving data to a cue 4-6
saving the link-set as a file 6-8
Séance 1-2

Séance network port 2-8
Select the desired console 2-1
Select user 5-2

Selecting cues 4-5

Sequence 8-9

Shift click 3-3

Show All Links 6-6

standard MIDI-file 8-12
start-up options 5-1

Static MIDI 8-2

step time 9-5

T

TCP/IP software 1-2

the order or sequence of the cues 4-5

Title Bar 3-2
title colour 4-11
Tool Bar(s) 3-3

U

Undo 4-12

undo an Import or GetMaps 2-7
Undo List 4-12

Update Séance 2-9

update the Seance program 2-9
USA or Japan format 8-6

User Properties 5-3

User Setup files 5-6

Using the module names 7-6

\Y

View Properties 5-4

w

What constitutes a show 6-9

X

X-Act Indicators 8-15
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